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Licensed Software Notice 
 

The software described in this manual is subject to the: 

MCN™ Standard Software License Agreement. 

A copy of the above referenced License Agreement is included on the distribution media for this 

software.   

LIMITATION OF LIABILITY 

IN NO EVENT WILL CTI OR ITS SUPPLIERS BE LIABLE FOR LOSS OF OR CORRUPTION TO 

DATA, LOST PROFITS OR LOSS OF CONTRACTS, COST OF PROCUREMENT OF 

SUBSTITUTE PRODUCTS OR OTHER SPECIAL, INCIDENTAL, PUNITIVE, CONSEQUENTIAL 

OR INDIRECT DAMAGES ARISING FROM THE SUPPLY OR USE OF THE LICENSED 

SOFTWARE, HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY (INCLUDING 

NEGLIGENCE). THIS LIMITATION WILL APPLY EVEN IF CTI OR AN AUTHORIZED 

DISTRIBUTOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, EXCEPT TO 

THE EXTENT THAT LIABILITY MAY NOT BY LAW BE LIMITED OR EXCLUDED, AND 

NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF ANY LIMITED REMEDY. 

IN NO EVENT SHALL CTI'S LIABILITY EXCEED ONE HUNDRED DOLLARS ($100). YOU 

AGREE THAT THE FOREGOING LIMITATIONS REFLECT A REASONABLE ALLOCATION OF 

RISK. 

CTI HAS NO CONTROL OVER THIRD PARTY CLIENT SOFTWARE AND MAKES NO 

WARRANTIES OF ANY KIND FOR SUCH SOFTWARE.  THE SUPPLIERS OF SUCH 

SOFTWARE SHALL BE RESPONSIBLE FOR ANY SUCH WARRANTIES. 

SOME STATES OR OTHER JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR 

LIMITATION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE 

ABOVE LIMITATIONS AND EXCLUSIONS MAY NOT APPLY TO YOU. 

U.S. GOVERNMENT RESTRICTED RIGHTS 

The Licensed Software and documentation thereto are deemed to be "commercial computer software" 

and "commercial computer software documentation", respectively, pursuant to DFAR Section 227.7202 

and DFAR Section 212.212, as applicable. Any use, modification, reproduction, release, performing, 

displaying, or disclosing of the software or documentation by the U.S. Government shall be governed 

solely by the terms of above referenced License Agreement and shall be prohibited except to the extent 

expressly permitted by the terms of that Agreement. Any technical data provided that is not covered by 

the above provisions is deemed to be "technical data-commercial items" pursuant to DFAR Section 

227.7015(a). Any use, modification, reproduction, release, performance, display or disclosure of such 

technical data shall be governed by the terms of DFAR Section 227.7015(b).  
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Revision History 

 

S2-61043-210 MCNRCD for Windows  

 

S2-61043-240 Updated Manual to remove obsolete procedures and information. 

 

S2-61043-245 Updated Screen Shots 

    

 

S2-61043-250 Release for MCN Standard Version 7.20.xx 

  Added support for HIB-IP 8002 Module 
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Introduction 

This manual covers the installation, configuration, and operation of the MCN (Monitoring and Control 

Network) Standard software.   

The standard version of the MCN software has capabilities as indicated below. 

Function Standard  

Number of Network 

Interfaces supported 
1 

Remote Client Support No 

Support for Third Party 

Clients 

No 

The manual may refer generically and interchangeably to this application as “MCN Standard" or 

"Standard Software".   

RCD stands for "Remote Comparator Display".   

The Standard software has executable file names as shown below: 

Program   Shorthand  Executable file name 
Hardware Setup  HWSetup Standard  Hardware Setup Standard. exe 

Configuration Program MCN Config standard McnConfig Standard.exe  

Monitoring Program  MCN Standard  MCNRCD Standard.exe 

 

Major sections of the manual comprise of: 

Introduction General discussion of the MCN Monitoring & Control Network, 

system requirements for the MCN Standard  software. 
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Installation Installation of the MCN software (and the PCLTA Driver Software 

if used).  

System Configuration This is the largest part of the manual, because it describes in detail 

all the system configuration features and options.   

Mcn Standard Program This covers the operation of the MCN Standard run-time program.   

Appendices Troubleshooting, special configuration, etc.  
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Example System Diagrams 

System diagrams in this manual are included to illustrate example generalized systems and principles 

and are not intended to reflect any particular system configuration.  In particular, a simplified IP 

infrastructure is shown.  Real-world IP networks may require and include additional routers, gateways, 

switches, etc. 

 

Typical Monitoring & Control Network (MCN) Systems 

There are a few things that must be configured and connected in order to establish a working system. A 

typical Mcn Standard is shown in the figure below attached to an MCN network.  The MCN Standard 

Remote Comparator Display system consists of: 

 An Mcn Standard PC running MCN the Standard program. 

 One or more network interfaces for the Mcn Standard PC (such as a HIB-IP, internal PCLTA or 

HIB-232). 

 One or more Comparator I/O Modules (such as an AIB or CIB). 

 Optionally, other interface modules (such as IOB) to drive auxiliary outputs and alarms. 

 

Figure 1 - Simple MCN Standard System 
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MCN System Overview 

The main programs that make up the MCN Standard software package: 

 MCNConfig Program  

(McnConfig Standard.EXE) 

This is the configuration program run by the system designer such as an engineer or technician to 

build the configuration files when the system is installed or changed. 

 Mcn Standard  Program  

(McnRcd standard.EXE)  

This is the program that runs on the Mcn Standard PC.  It has a local display that displays the 

status of the devices on the MCN system (Comparators, I/O points, alarms, etc.).  It allows the 

operator to control receivers (with Force-Vote and Disable functions) and other I/O devices 

(relays, etc.) from the Mcn Standard PC.  

 

The Mcn Standard program does not support any clients. 

Reference Documents 

Details of other hardware components of the system can be found in the following documents: 

 Monitoring and Control Network, System Manual 

Part Number S2-60425 

 HIB-IP Remote Network Interface Hardware Reference Manual  

Part Number S2-61173 

 HIB-232 Host Computer Interface Module, Hardware Reference Manual 

Part Number S2-60427 

 CIB Comparator I/O Module, Hardware Reference Manual 

Part Number S2-60426 

 AIB Astro-TAC Comparator Interface Module, Hardware Reference Manual 

Part Number S2-60399 

 IOB I/O Control Module, Hardware Reference Manual  

Part Number S2-60630 

 EXB-232 and EXB-IM Network Extender Modules, Hardware Reference Manual 

Part Number S2-60596 

 EXB-IP and EXB-FI Network Extender Modules, Hardware Reference Manual 

Part Number S2-61089 

 Router Modules, Hardware Reference Manual 

Part Number S2-60649 
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Package Contents 

All MCN Standard System packages will include the following: 

Software CDs  

The MCN Standard software package includes: 

 Installation Program: 

The standard Install shield program is used to install the software on a Single PC. 

The CD contains the HwSetup, McnConfig, and MCN Standard software only. 

 HWSetup Program: 
This is used to select which network Interface to use for legacy hardware support. 

No software Key is required for this system to operate. 

 MCNConfig Program:  (McnConfig Standard .exe) 
This is the configuration program that is used by an engineer or technician to build the 

configuration files when the system is installed or changed. 

 MCN Standard   Program: 
This program operates on the Mcn Standard PC.  It has a local display that displays the status of 

the devices on the MCN system (Comparators, I/O points, alarms, etc.).  It allows the operator to 

control receivers (with Force-Vote and Disable functions) and other I/O devices (relays, etc.) from 

the Mcn Standard PC.  

 

System/User Manuals 
 Hard copies of the System, User and Hardware manuals.( Including this Manual ) 

 PDF copies of System, User and Hardware manuals.   

 

********* MCN Standard System package does not include the following:  ********** 

 

Hardware Key (for Mcn Server versions Only) 
 Not used with the Standard software version 

Software Key CD (for Mcn Server versions Only) 
 Not used with the Standard software version 

No PCs Included 
The MCN Standard software package does not include any PCs. 

 

 

NOTE: The MCN Standard program does not pass any status and control data to MCN Client 

 PCs.   
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PC Hardware Requirements 

Mcn Standard software requires a PC with the following minimum system configuration: 

 Windows Vista, or 7, Windows Server 2003, 2005, 2008R2 

 Pentium D or Core i3 at 2GHz or above. 

 2 GB Memory. 

 Color Monitor with at least 800 x 600 resolution, higher resolution recommended 

 Mouse 

 100Base-T Ethernet port 

 One open serial port if the local network interface is a HIB-232 

 CD ROM Drive 

 Open USB Port 

 One open PCI slot if the Network Interface is a PCLTA  

(only for 32-bit operating systems) 

 

Note: All PCs are not equipped with an available and correct type of PCI slot.  

 Check the manufacturer mother board specifications carefully for compatibility. 

 

 

Supported Operating Systems 
  

MCN 

Program Version 

Win 

XP 

Serv 

2003 

Win 

Vista 
Win7 

Server 

2008 R2 

  32B 64B 32B 64B 32B 64B 

Mcn 

Standard 

 

3.xx   -- -- -- -- -- -- 
4.xx   -- -- -- -- -- -- 
5.xx         

6.xx         

7.xx -- --       

 Fully Supported 

 Only supports systems using HIB-232 and HIB-IP Network Interfaces.  PCLTAs are not 

 supported under 64 Bit OS versions. 

--  Not supported. 

 

 NOTE: Support for Windows 2000 has been discontinued in Version 5.00.   
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Released Software Versions and Options  
 

The following table, list the different versions of the MCN software and the specific features that are 

available with each one. 

 

MCN 

Program 
Ver. 

Client 
& 

Server 
Clients Dial Up 

Network 

Interfaces 

Supported 

TCPI 

Standard 
Up to 

7.x 
No No 

Yes With  

HIB-232 
One (1) No 

 

User Access Control 
Permission windows have been added since Version 5.x in the following programs, for when a user 

makes a change that requires access rights under the Windows User Access Control scheme: 

 HWSetup 

 MCN Config Standard 

 Mcn Standard 

 

Network Interfaces & Drivers 

A Network interface is required to establish a communication link between the monitoring PC running 

the MCN Standard software and the MCN Network with its various modules. 

There are three general categories of MCN Network Interfaces that can be used with Mcn Standard 

program: 

HIB-IP External Modules For connection to MCN networks over IP networks 

HIB-232 External Modules For Local RS-232 connection; (Although the HIB-232 manual 

talks about dial-up operation, the Mcn Standard program is 

intended to be connected full-time to the MCN network(s) that 

it serves.    

Internal Boards PCLTA-21 For direct connection to the MCN Network 

Supported only by 32-bit operating systems. 
(Also supports connection to remote networks using EXB 

Network Extender Modules) 

Supported Network Interface Details 

The Mcn Standard program can use the following versions of HIB modules or the PCLTA cards for the 

interface between the PC and the MCN network.   

HIB-IP Modules Version 110 & up 78K (Also includes HIB-IP 8000 & 8002) 

 

HIB-232 Modules  Version 200 & up78K (with Rotary address 

switches on back)   
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PCLTA-21 Boards Half-Size PCI boards  78K or 1250k versions 

  Only for 32-bit operating systems. 

The PCLTA card is one of the Network interface types which can be used with the MCNRCD solution. 

The PCLTA-21 model is specifically a 32 bit PCI card type with the universal 3.3v and 5v compatibility 

for use with Conventional slots. See Figure 2. 

Note: All PCs are not equipped with the correct type or number of available PCI slots. Check the 

manufacturer motherboard specifications carefully for compatibility. 

 

Figure 2 

 

Warning: PCLTA Internal PCI Network Interfaces are supported only with 32-bit operating systems, 

since device drivers for the PCLTA cards are not available for 64-bit operating systems.   

 

Unsupported Network Interfaces 

The following older Network Interfaces are not supported with Mcn Standard 

HIB Modules  Version 000-199 (without Rotary address switches on back)  

PCLTA (original) Full-size ISA bus boards 78K or 1250 versions 

  Single or dual interfaces 

PCLTA-10 Half-size ISA bus boards 78K or 1250 versions 

PCLTA-20 Half-size PCI bus boards 78K or 1250 versions 

All HIB-232 modules have a unit number of S2-60081-xxx.  If the ‘xxx’ number is less than 200 you 

have an early version HIB module that is not supported. 

 

Network Interface Drivers for Mcn Standard and MCNConfig 
Standard  
There are a couple of drivers that may need to be installed, depending on the type of Network Interface 

that is being used. 

 The PCLTA Interface boards need a software driver to run the Mcn Standard program.   

This will be included with the PCLTA & software package.  This drive is only available for 32-

bit operating systems.   

 The HIB-IP 8002 module requires a USB driver to be installed, before any of the MCNConfig 

applications can perform its’ hardware configurations. (The older HIB-IP and HIB-232 modules 

do not need a driver for normal operation of the Mcn Standard program.) 
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Installation 

Installation Overview 

The installation of the Mcn Standard software and network interfaces should be done in the following 

order: 

1) If a PCLTA network interface will be used, install the PCLTA device drivers first and then the 

network interface card, before testing the interface.  See Installing PCLTA Network Interface (If 

needed) on Page 18. 

2) Run setup.exe on the Mcn Standard PC to install the Mcn Standard software.  See Installing MCN 

Standard Software on page 23. 

3) Run the MCNConfig program to customize the MCN System Resources and display windows for 

your system.  See MCNConfig Program: Configuring System Resources on Page 48. 

4) If you are using HIB-IP units, program them using MCNConfig program.  See Programming HIB-

IP and HIB-IP 8002 Units on page 52. 

5) Run the Mcn Standard program on the Mcn Standard PC.  See Mcn Standard Program on page 

121.  You will be asked to enter the MCN Software Key and IP parameters on the first use.   

 

Example Screen Captures & Example Data 

Example screen captures with various details of the programs are shown throughout this manual to give 

the reader an example of what to expect during setup, installation, and operation of the software.  Newer 

versions of the software may include updated windows with slightly different wording or additional 

fields and features. 

Data shown in example screen captures is presented only for example purposes only.  It does not reflect 

any particular user's system. 

Various sections of the manual focus on particular topics.  Example screen captures within a section are 

presented as examples of the topics covered in that section.  Example data show in the screen captures in 

one section may not apply to screen captures shown or system configuration described in different 

sections.  

IP Addresses, Subnet Masks, and Gateway IP Addresses, shown in the manual may not necessarily be 

compatible for the appropriate linking between HIB-IP modules and the Monitoring PC.  They were 

taken from test systems in a lab and are used as examples only.  They do not reflect your required system 

settings, and should not be taken as recommendations.   
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** Quickstart Setup Procedure ** 

Initially, it may be desirable or even necessary to quickly configure a working MCN system. The 

following outline will assist and guide you through the necessary steps to do so.   

Gather System Information 
A. What you need to know: 

I. The Type and Quantity of the Equipment that will be monitored.  

 

II. Whether MCN network monitoring will remote or local to the MCN Standard 

PC. This must complement the type of NI device which has been purchased. 

 

III. If remotely monitored, what method will be used to connect the Remote 

location to the MCN Network; e.g. WAN, PSTN, T1 Trunk or Other. 

 

If locally monitored, whether the PC will connect to the local MCN Network 

via LAN or RS232. 

 

IV. What type of MCN Network Interface (NI) you will be connecting to. 

 

 Install and Setup 

Software Installation: Installation details on standard software. Pages 23 

 Standard   (Single Interface, No Clients, No SW Key) 

 

 

HW Setup Program: Pages 26-31. 
   (Using the information gathered previously choose the NI to configure.) 

 If PCLTA or Dial up  Pages 27 

 If HIB-232 Serial    Pages 30 

 If HIB-IP    Pages 31 

 

 Building a System; (Use the MCN-Config Standard Program) 
 

Add Network Interface:  
  (Minimum is one; Maximum is one for Mcn Standard versions.)  

 

Use ‘Network Interface’ window: (MENU:  View / Network Interface)  

See Page: 49 Select and configure the appropriate type of interface: (PCLTA, HIB-232, 

HIB-IP) 

 

Add Channels and/or Channel Names: 
  (Optional, but recommended to provide better clarity for the Displayed statuses) 

 

Use ‘Channels’ windows (MENU: View / Channels) 

  See Page: 58 
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Add Hardware Modules:   (Minimum Requirement is one) 

  Use ‘Hardware’ window: (MENU:  View / Hardware) See Page: 56 

  Add the correct type of Monitoring interface device. (e.g. Select CIB for a Comparator 

  interface board).  Other options: (AIB, IOB, GPIO) 

 

Enter Receiver & I/O Point Names & Information:  
  Use ‘Receivers’ window: (MENU:  View / Receivers) See Pages: 63 

  Enter data for all receivers & I/O Points in the Receiver Window. 

  Select the proper Display Table Type (Comparator, Generator, Door, etc.) for all 

  Receivers & I/O points.   

 

Email Group:  (Optional, for problem reporting.)  
  Use ‘Email Group’ window: (MENU:  View/ Email Group) 

  See Pages: 60 

 

Display Windows: 
Use ‘Display Windows’ window: (MENU:  View/ Display windows) 

  See Page:  76 

  Creates and configures the screen Layout and Appearance of the receivers to be  

  displayed. 

 

Display Tables: 
  Use ‘Display Tables’ window: (MENU:  View/ Display windows) 

  See Pages: 67 

  Translates the bit data of the hardware, into specific indications on the status display

  screen.  
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Installing PCLTA Network Interface (If needed) 
PCLTA Internal PCI Network Interfaces are supported only on 32-bit operating systems.  Drivers for the 

PCLTA cards are not available for 64-bit operating systems.  

If you are not using a PCLTA card, skip to the Installing MCN Standard Software section on page 23. 

PCLTA Device Driver Installation (32 bit operating systems only) 

Insert the PCLTA driver CD into the CDROM drive.  When the CD contents folder is displayed as 

shown below, double-click the “OpenLdv Install 3_40.exe”  file to start the installation of the PCLTA 

device drivers and OpenLdv. 

 

 
 

The OpenLDV Install welcome screen will be displayed as shown below.  Before continuing, it is 

recommended that you exit all Windows programs.  

  

 

Click the Next button to display the “Software License Agreement” window as shown below. 
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Click on “I Accept the terms in the License agreement” then click the NEXT button.   

OpenLDV and the PCLTA drivers will be installed.  Once complete, the “Setup Complete” window will 

be displayed as shown below. 

 

  

Click the Finish button.   

Finally, you must power down the computer before installing the PCLTA network interface card. 

Installing PCLTA Network Interface Card 

The PCLTA device drivers must be installed prior to installing the card.  If the drivers have not been 

installed, complete each of the previous steps for this section. 

To install a PCLTA card into your PC, follow these steps: 

1. Turn off the PC and remove the power cord. 

2. Open the PC case and locate an empty slot.   

3. Remove the corresponding blank panel from the rear of the PC. 
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4. Insert the PCLTA card into the slot, ensuring that the edge connectors are fully mated, and the 

slot in the rear panel-mounting lug of the PCLTA is aligned with the threaded hole in the PC 

chassis. 

5. Replace the screw to hold the PCLTA firmly in place. 

6. Reinsert the power cord and then restart the PC. 

On power-up, Windows will automatically sense the Plug-n-Play adapter, and associate it with the 

drivers installed in the previous step.   

If the Plug ‘n Play features of the card failed, the following “Found New Hardware Wizard” window 

may be displayed. 

  

Select “No, not this time”, then click the Next button to display the following window. 

  

On the above window, select “Install the software automatically”, and then click the Next button.  Click 

the Next or Finish buttons in the remaining windows to complete the installation. 
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Configure and Test the PCLTA Network Interface 

Configure & test the PCLTA board as shown below.  It will not run if it is not configured. 

the From the Start menu button on the Windows desktop, select Control Panel from the list, and then 

double click the “LonWorks Plug ‘n Play” icon.  (If the “LonWorks Plug ‘n Play” icon is not visible, 

change the Control Panel properties to “Classic View”.)   

The following “LonWorks Plug ‘n Play” window will be displayed. 

 

 

In the NI Application drop-down list, choose an image that is compatible with MCNRCD from the 

following table.  (For all operating systems, the Image name should end with “L7”.)  Then click the 

Apply button. 

 Windows XP, Vista, 7 (32 bit versions only) 

Images Compatible with MCNRCD PCLTA21L7 

Images to Avoid PCLTA21VNI, PCL10VNI 

 

To check if the PCLTA network interface has been installed correctly, click the Diagnostics button to 

display the following window. 
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Finally, click the Test button to display status information similar to the following window. 

 

When finished, click the OK button on this “LON1 Diagnostics” window, and then click the OK button 

on the “LonWorks Plug ‘n Play” window. 

If the PCLTA network interface card was installed prior to device driver installation, the PCLTA may 

not function correctly.  To correct this situation, see Appendix:  Fixing a Botched PCLTA Installation 

on page 141. 

Cabling and Termination 

The PCLTA card is different from all other MCN modules in that it does not have an RJ-45 connector 

for the network cable to plug into.  A ‘T’ Adapter (S2-60617), shown below, must be installed to 

connect the PCLTA’s two-pin connector with the MCN network cable.  Use one RJ-45 connector on this 

adapter for the network cable, and plug a terminator (either TP/XF1250 or TP/FT10) into the other. 

CA-8 0 2 7 3 -1 0 1

C A B LE

 



HW and SW Installation  
 

 23 S2-61043-250 

Installing MCN Standard Software  

Run Setup.exe from the CD. 

You must have Administrator rights to install the Mcn Standard software. 
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If you choose the custom installation, you can deselect program options which you do not wish  

to be installed; however this is atypical and not recommended. 
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This screen might be visible only in older versions of the windows OS. 
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Hardware Setup – (HWSetup Standard.exe) 

The Hardware Setup program is used to select and set up the Network Interface (PCLTA, Dial UP, 

Non-Dial-up HIB-232, or HIB-IP) to use in the system.  

Network Interface Setup  

The first time HW Setup is ran, it sees that there is no Network Interface defined on the PC. It will ask 

you what type of Network Interface (NI) you plan to use.  

 

Select the type of Network Interface you intend on using with your system, from the list of possible 

types available.  

Important The standard version of MCN program will allow the selection of  only one Network Interface 

from this window; So if the wrong interface is selected you will have to remove it first, before you can 

add the correct one.    
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Network 

Interface Type 

Description 

PCLTA Internal board in the PC.  The MCN network will connect directly to this board. 

If there is a PCLTA board that is properly installed, the HW Setup program will list it in 

the "Possible Types" list. See:  PCLTA Setup 

HIB-232 - 

COMx 

Non-Dial-up HIB-232 units 

- Non-dial-up HIB-232s connect to a COM port directly 

  or through external leased-line modems or equivalent. 

- The program detects all COM ports reported by Windows.   

   Depending on your PC, not all ports may be available for use.   

      Some COM ports may not be brought out to a connector. 

      Some COM ports may be reserved for an internal modem. 

      (For example in the snapshot above, COM3 is actually an internal modem.) 

See HIB-232 (Non Dial-UP) 

HIB-IP Remote Network Interface that connects to the PC through an IP channel 

 

You will set up parameters for the HIB-IP unit in the system database by using 

McnConfig program.  (You will also have to download those settings to the HIB-IP from 

the McnConfig program.)  

 PCLTA Setup  

If a PCLTA Card (and its driver) are properly installed on your PC, the HW Setup program will detect it 

and present it in the Possible Types list box.  

You can check to see if the PCLTA card is installed and operational, by going to Control Panel and 

running the Lonworks application.  You may then click on the Diagnostics tab; if the installation was 

done correctly there will be a status box without error indications. 

Warning: There are no PCLTA drivers available for 64 Bit Operating Systems. 

 

 Select the PCLTA and click the Add NI button. 
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The Group/Module address defaults to “F0/10” during installation.   

 Change the Group and Module address as required for your system. 

 Click the OK button. 

Important:  MCN Address Setting 

Each PC and each MCN module in the system must have a unique address.  If you are setting up 

multiple PCs, be sure to set up each PCLTA card with its own address.   

If you have a Custom Engineered System (with custom system documentation part number  

KA-8xxxx-xxx), be sure to set the PCLTA address to the Group & Module numbers shown in your 

documentation.  Failure to do so may cause the system not to work 

In the above window, click the OK button. The Network Interface window will re-appear: 

 

Click the Next button.  

 

Click the Finish button in the confirmation window.   

The appropriate information for the PCLTA is now stored in the registry and will be available for use by 

McnConfig and Mcn Standard programs.  

The MCN Group and Module addresses are set up on hex rotary switches on the back of the HIB-232 

unit. 
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PCLTA / HIB-232 (Dial-UP)   

If you have to connect with leased line modems you will need to use a HIB-232 module.  

Select the Dial UP HIB-232 port from the Available Types list box as shown below: 

 

 

If the Modem must be configured to dial select ‘Enable Router’ and click Ok. 

 

Once the settings for the Dial UP HIB-232 are verified and confirmed, click Finish. 
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HIB-232 (Non Dial-UP) Com x 

If you have a HIB-232 module and are using it directly connected select the proper COM port from the 

Possible Types list box: 

 

The program detects all COM ports reported by Windows. 

Depending on your PC not all ports may be available for use. 

  *   Some COM ports may not be brought out to a connector. 

  *   Some COM ports may be reserved by an internal modem. 

      (For example: In the snapshot above, COM3 is actually an internal modem.) 

USB to Serial Adapters 

The Mcn Standard program will work with some USB to Serial adapters.  We cannot guarantee that it 

will work with all such adapters since we cannot test all brands.   

Important: Some USB to Serial adapters will change their COM port number when they are plugged 

into a different USB connector.  If you are using one of these and you change its connection, you will 

have to re-run the HW Setup program to select the new COM port. 

 Select the proper COM Port and Click the Add NI button 

 

 Select the appropriate baud rate. Be sure that the baud rate matches the Baud rate switches on 

the HIB-232 module. 

 (The Group and Module addresses for the HIB-232 unit are set with rotary switches 

 on the unit.  See Important:  MCN Address Setting on Page 28 for more information on  MCN 

 addressing. )  

 Click the OK button. 



HW and SW Installation  
 

 31 S2-61043-250 

 

 Click the Next button for the above window. 

 

 And Click the Finish button. 

The HW Setup program will save the setting in the registry. 

This setting will be used by the Mcn Standard program. 

 
 

 

 



HW and SW Installation  
 

 32 S2-61043-250 

HIB-IP 

If you will be using a HIB-IP unit, select it from the Possible Types list. 

 

 

 Select the HIB-IP option.  (Although the line says "One or more HIB-IPs", you will be able to 

use only one HIB-IP with the standard Mcn Standard program.  If you need to connect to 

multiple HIB-IP units at a time, you'll need the MCN Advanced Server software. 

 Click the Add NI button. 

 

 Click the OK button. 

 

 Click the Next button 
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 Click the Finish button. 

 

HIB-IP Parameters 

As shown in the “Setup HIB-IP” window above, you will later need to enter the HIB-IP parameters in 

the system database using the McnConfig program.  You will also have to download those parameters to 

the HIB-IP using McnConfig. 

 

Miscellaneous Installation Considerations 

Changing Settings for your Network Interface 

If you need to Change, Remove or Add a Network interface, re-run the HWSetup program.  This 

program can be used to change the: 

 Type of Network Interface 

 PCLTA Device or Group & Module address 

 HIB-232 COM Port or Baud Rate 

 

To change these items you can either: 

 Double click on the Network Interface to edit its parameters or 

 Click the Remove button to remove the Network Interface and select a different one. 

Warning: If you have a Custom Engineered System (with custom system documentation part number 

KA-8xxxx-xxx), be sure to set the PCLTA address to the Group & Module numbers shown in your 

documentation.  Failure to do so may cause the system not to work 



HW and SW Installation  
 

 34 S2-61043-250 

In the above window, click the Next button 

Changing the PCLTA Group/Module Address 

If the Group/Module address for the PCLTA Network Interface needs to be changed (or to query the 

PCLTA for its current address), simply run the hwsetup.exe program.  This program can be found in the 

main program working directory (typically c:\Program Files\CTI Products Inc\McnRcd).  Then click the 

Next button until the following window is displayed. 

 

The Group/Module address defaults to “F0/00” during installation.  However, each PC must have a 

unique address. 

In the above window, click the Next button, then the Finish button to complete the address change for 

the PCLTA Network Interface. 

 

PC Power Options Setup 

The “Power Options” icon in the Control Panel allows for a wide variety of PC operation parameters.  

However, installation of Mcn Standard software will disable any possibility of the PC going into the 

Standby or Hibernate Mode. 

The monitor may be allowed to “sleep” as long as the “Monitor Timeout” is less than the “Standby 

Time”.  Otherwise, the monitor will never sleep. 

 

Printer Installation 

For printer logging to occur, a printer must be installed from the Windows operating system.  From the  
‘ Start ’ menu button on the windows desktop, select “Printers and Faxes” from the list, then select 

“Add a Printer” from the list of “Printer Tasks”. 
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Uninstalling Mcn Standard software 

There are a few methods for uninstalling the MCN software suite provided below. Certain methods 

support Installed feature selection while others only perform complete removal. 

Using the Installation Disk (Removes all or selected features) 

To uninstall Mcn Standard software or any of its features, you can use the Installation CD. 

Insert the Mcn Standard distribution CD into the CDROM drive. If ‘Autoplay’ is enabled  

in your windows OS, a Dialog/options box should pop up with options to ‘Run setup.exe’. 

After clicking the Run setup.exe, you may choose to either remove specific features or the 

entire program suite and all installed features.  

If the Autoplay feature is disable use the following ‘Menu method’ 

Click the Start menu button on the Windows desktop, then select “Run” from the list.  In the 

“Run” dialog box, type d:setup.exe (where d is the drive letter of the CDROM drive), then 

click the OK button.  In the “InstallShield Wizard” window, select “Remove”, then click the 

Next button.  Follow the prompts until the InstallShield Wizard completes the removal process. 

Using the Control Panel (For complete removal only) 

Click the Start menu button on the Windows taskbar, select control panel from the list. 

Depending on your view selection, choose either ‘Programs’ or ‘Programs and Features’. 

Locate and double click the Mcn Standard name from the list and follow the prompts. 

 

 

 



System Configuration  
 

36 

S2-61043-250 

System Configuration 

Overview of MCNConfig 

The MCNConfig program is used to configure an MCN system.  System configuration involves: 

1. Defining system resources in the Resource Windows, such as Network Interfaces, Hardware 

Modules, Receiver Names, Channels, and Email Groups. 

2. Designing the Display Windows to be displayed for the Mcn Standard program. 

 

Resource Windows 

The MCNConfig program will be used to define your system by entering data into the following 

Resource Windows. (There is only one of each type of Resource Window for each system.) 

 Network Interface Indicates which Network Interface is used for this system. 

If you are using a HIB-IP unit, this is where you will enter the  

IP and MCN address settings. 

 Hardware Enter the information about the hardware modules. 

(CIBs, AIBs, IOBs, etc.) present in the system. 

 Receivers Enter the site Names and Descriptions for all the receivers in the system. 

 Channels Enter the names of the radio channels used in the system.  Each channel can 

have multiple hardware modules. 

 Email Groups Enter the Email Groups & Recipients for alerts generated by the Mcn 

Standard program. 

 Display Tables Each type of device to be monitored and controlled will have a Display 

Table. The Display Table maps the hardware I/O bits of the device into 

status indications.  

The Mcn Standard software ships with the standard Comparator Display 

Table and a number of generic I/O Display Tables. 

 

Customized Display Tables can be created with special status text displays 

(On/Off, Alarm,, Run/Normal, etc.) for control and monitoring devices in 

your system.  
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Certain fields of the resource windows link to each other as shown by the arrows. 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 So you should notice that the Network Interfaces ‘NI’ in the ‘Hardware window are directly 

linked to all those Receivers in the Receiver window with the same Group and Module address. 

 

 The Aliases entered in Channel windows can be selected and directly assigned to be channel 

names for the configured modules in the Hardware Window. 

 

 The Email addresses configured in the ‘Email Groups’ window can be selected and directly 

assigned to a channel name in the Channels window. 
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The Display Window 

The Display Window contains the status screens that you build for the Mcn Standard programs.  Each 

status screen can contain multiple Tabs and multiple channels; but also Multiple Screens can be defined 

within the Display window for a system. 

 

If there are multiple screens built within the Display window, you will have to click the “View” tab and 

select “Display Window” and choose which specific screen you want to view. 

  

 

 

 

 

 

Renaming a Screen 

You can rename existing screens if changes are made to the system; by opening the specific screen, 

clicking the “Edit” tab and selecting “Display Window Properties”. 
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Typical Technician Display Window 

The following is an example of the Display Windows configurability: 

 For Technicians, a large display grid with one tab showing all systems on a single grid. 

 For Dispatchers, a small grid with multiple tabs showing only one channel per tab. 

 Different Display Windows for different dispatchers with different subsets of channels available. 

(Police channels for Police dispatcher, Fire & EMS channels for Fire Dispatcher, etc.) 

 
 

Typical Dispatcher Display Window 

Example System 

You can load the Example System from the “Example System” directory off the main program directory  

(typically c:\Program Files\CTI Products Inc\McnRcd\Example System).
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Navigating The MCNConfig Program:   

The MCNConfig program is a 32-Bit Windows program.  Navigation, menus and toolbars are similar to 

other Windows programs.   

 Standard Windows Hot-Keys that can be used with this program include: 

Ctrl-C Copy current selection to clipboard 

Ctrl-V Paste clipboard to current location in selected window. 

 Context Sensitive Menus are available in different windows by Right-clicking an item. 

 Scroll Bars are available when the contents of a window (other than the main window) are 

larger than the size of that window. 

Controlling the Windows 

You can have multiple windows (resource windows or display windows) open on the workspace at a 

given time.  You can control the windows as follows: 

 View the Resource Windows (Hardware, Receivers, Channels, Display Tables or Email Groups)  

or Display Windows with the View menu. 

 Select an open window by clicking the mouse on it or using the Window menu. 

 Move a window by grabbing its title bar and dragging it. 

 Re-size a window by grabbing an edge or corner and dragging it. 

 Minimize /Restore, Maximize and Close the window using the standard Windows buttons on 

the top right corner of each window.  If you close the last window, you will close the system.  If 

changes have been made, you will have a chance to save the system. 

 You can save the sizing and layout of your workspace by using the Save Layout command in the 

Edit menu. 

Screen Elements 

 

Menu Title Bar 

Min / Max / Close 
Buttons Toolbars 

Status 
Line 
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This program has many standard menu functions that are used in other Windows programs.  For 

example, menus can be selected with the mouse or by holding down the ALT key while pressing the 

underlined letter on the menu. Note that a menu’s appearance may change, and various menu options 

may be disabled, depending on the current state of the system. 

Menu Bar 

Two versions of the Menu Bar will be displayed. When there is no system opened, a small Initial Menu 

Bar will be displayed: 

 
 

When a system is loaded, the standard Menu Bar will be displayed: 

 

Initial File Menu 

When there is no system loaded, the Initial File Menu is available. 

 

New Starts a new system from scratch. 

Open Opens an existing system from disk.  This will open all the 

files associated with a particular system. Only one system 

can be open at a given time.  You must close the existing 

system before starting a new system, importing a system 

from the DOS version of MCNRCD , or opening another 

system. 

Import Imports a system from the DOS version of the MCNRCD 

program. 

Recent Files Allows you to quickly open a recently used system. 

COM Port Selects the COM port used to program HIB-IP units 

Exit Exits the program. 

Standard File Menu 

Once a system is loaded, the Standard File Menu is available: 

 

 

Close Closes the current 

system. 

If something has changed, you will be given a chance to save it.  

Save Saves the current 

system with the current name. 

This will save all the files associated with a particular system. 
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Save As Saves the current system with a new name. 

This will save all the files associated with a particular 

system. 

Print Prints the contents of the currently selected window. 

COM Port Selects the COM port used to program HIB-IP units 

Exit Exits the program. If something has changed, you will be 

given a chance to save it. 

The Standard File Menu does not have the Open, Import, or Recent Files menu items. 

Saving Files 

We recommend that you save the system in a subdirectory or sub-folder of the main program’s 

working directory (typically C:\Program Files\CTI Products Inc\McnRcd Standard). When you  

first save a system, Windows may default to the My Documents folder.  If so, browse to the working 

directory and add a new directory for your system description files.  

Edit Menu       
The Edit Menu is available whenever a system is loaded. Some menu  

items may not be enabled depending on the currently active window.   

 

Note: Any font settings made from here are only effective within MCN Config program.  The font 

settings for the Mcn Standard programs are set by the user from within those programs. 

 

  
 

Cut  Cuts the selected item(s) and saves a copy in the clipboard.  

Copy Copies the selected item(s) to the clipboard.  

Paste Pastes the contents of the clipboard to the current cursor 

location. Some fields are special fields and will only accept 

certain data (or certain ranges of data) from the clipboard.  

See Restrictions on Using the Clipboard on page 91 for 

more details. 

New Display Window Opens a new MCN Display Window. 

Delete Display Window Deletes an MCN Display Window. 

Display Window Properties Sets the properties (Window Title, Number of Rows & 

Columns) for the currently selected MCN Display Window. 

Email Group Properties Sets the properties (Group Name, Hold-off Time) for  the 

currently selected Email Group. 

Display Font Only available to set the font and size of text within the 

Display Window; Used to simulate the display for the Mcn 

Standard program. 

Table Font Sets the font and size of text within currently opened, active 

windows. Not active in the Display Window. 
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View Menu 

The View Menu is used to display a list of available windows, from which you may quickly select and 

make active for use.  Some items will only appear when certain options are purchased with the License. 

   

 

  

 

Status Bar Turns the Status Bar (at the bottom of the screen) on or off. 

Enable Sub-Comparators Displays a tab for Sub-comparator fields and options in the 

Display Table and Receiver Window.  Turn this off for a 

less cluttered screen view if sub-comparators are not used. 

Network Interface Opens the Network Interface Window and makes it active. 

Hardware Opens the Hardware Resource Window and makes it active 

Receivers Opens the Receiver Resource Window and makes it active. 

Channels Opens the Channel Resource Window and makes it active. 

Email Groups Opens the Email Groups Window and makes it active.  

Display Window Opens an RCD (Remote Comparator Display) Display 

Window and makes it active.  

Display Tables Opens the Display Tables Window and makes it active. 

Layout Mode Turns on Layout Mode in a Display Window to enable re-

sizing of columns (active only when a Display Window is 

active.) 

 

Save Layout Saves the current working screen layout (Window 

Positions, Column widths).  This layout will be used the 

next time the program is started. 
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Window Menu 

 

 

Cascade Cascades all open windows 

Tile Tiles all open windows 

Window List  (1-N) Indicates currently open windows. Use this list to select and 

open a Resource (Network Interface, Hardware, Receivers, 

Channels, Email Groups, and Display Table) or Display 

window. The Resource Windows will appear in the order 

they were opened. 

 

Display Windows will be listed as named by the user. 

(Windows 6 & 7 in this screen shot are Display Windows.) 

Help Menu 

 
 

Help Topics Brings up the standard Help menu. 

About MCNConfig Displays information about the program. 

Toolbars 

The MCNConfig program has dockable toolbars indicated in the screen capture below. You can move 

the toolbars by clicking on the beginning or ending line in the toolbar and dragging it to the desired 

location. 
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Each Toolbar button has a Tool Tip that will be displayed when you hover the mouse over it.  A more 

lengthy description of the button will appear in the Status Line at the bottom of the main window. 

File Toolbar 

 New Opens a new system.   

Same as File … New menu item. 

 Open Opens a system from disk.  

Same as File … Open menu item. 

 Save Saves the current system to disk.   

Same as File … Save menu item. 

 Print Prints the data from the active window.   

Same as File … Print menu item. 
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Add Resource Toolbar 

 New Network Interface Module 
Adds a new Network Interface module to the Network 

Interface resource window.  (The Standard version of the 

Mcn Standard program supports only 1 Network Interface.  

If you need to support more than one Network Interface, 

you will need the MCN Advanced Server software.) 

 New Module Adds a new module to the Hardware List resource window.  

Adds the appropriate number of Receivers or I/O Blocks in 

the Receiver window. 

 New Channel Adds a new channel to the Channel List resource window. 

 New Email Group 
Adds a new Email Group (tab) to the Email Group resource 

window.  

 New Email Recipient  
Adds a new Email Recipient to the currently selected Email 

Group.  If no Email Group is defined, this will add a new 

Email Group.  

Edit Toolbar  

Items in the Edit Toolbar work only in the currently selected window.  If a toolbar item is not available 

in a particular window, it will be grayed out.  

Note:  Some fields are special fields and will only accept certain data (or certain ranges of data) from 

 the clipboard.  See Restrictions on Using the Clipboard  page 91 for more details. 

 

 Append Adds a new item to the end of a list of items.  This item is 

not available in the Receiver Window or Display Window. 

 Insert Inserts a new item at the current location in a list of items.  

This item is not available in the Receiver Window or 

Display Window. 

 Delete Deletes the currently selected item(s). 

 Cut  Deletes the currently selected item(s) and copies them to 

the clipboard. 

 Copy  Copies the currently selected item(s) to the clipboard 

without deleting them from the selected window. 
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 Paste Pastes the clipboard contents to the current location in the 

selected window: See Preceding Note. 

 

 Move Up  Moves up the currently selected item in the list.  This item 

is not available in the Receiver Window or Display 

Window.  

 Move Down Moves down the currently selected item in the list. This 

item is not available in the Receiver Window or Display 

Window. 

 Sort Numeric Sorts the Hardware Module list by MCN Group & Module 

numbers.  This item is available only in the Hardware 

Window. 

 Sort Alpha Sorts the list alphabetically. This item is available only in 

the Channel Window and the Email Window. 

Display & Help Toolbar 

 New Display Adds a new display window. 

 Display Window Properties  

Opens the Grid Properties dialog box. Allows changes to be  

made to the window Title, and the number of rows and 

columns for a Display Window.  This item is available only 

when a Display Window is selected. 

 New Tab Appends a display tab to the selected Display Window. 

This item is available only when a Display Window is 

selected. 

 New Label Adds a Label at the current position in the selected Display 

Window. This item is available only when a Display 

Window is selected. 

 New Receiver Adds Receiver(s) or I/O Group(s) to the current position in 

the selected Display Window. This item is available only 

when a Display Window is selected. 

 Help Displays the Help menu window. 
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MCNConfig Program: Configuring System Resources 

The process to configure a working system begins with configuring the following four Resource 

Windows: 

 Network Interface Window Displays the Network Interface selected for this system. 

 This window also lets you configure the IP settings for a 

 HIB-IP module (if used).  

 Hardware Window Define hardware modules & addresses 

 Receiver Window Define receiver names & I/O group names  

for all hardware modules 

 Channel Window Enter channel information  

 Email Group Window Enter email information for alerting 

 

Network Interface Window : Details 

This window displays the Network Interface selected for this system. 

This window also lets you configure the IP settings for a HIB-IP module (if used). 

 

 

The Standard version of the Mcn Standard software only supports a “single” Network Interface.  If you 

need to support multiple Network Interfaces, you'll need to upgrade to the MCN Advanced Server 

software. 

The Network Interface Resource Window includes the following fields: 

Name 
Network Interface Name (as stored in the database for this system) 

Type: 
Type of Network Interface Module: 

 Non-IP PCLTA (Lonworks or Dial up) 

  HIB-232 ( Serial/Non Dial up) 

 

 IP HIB-IP 

The settings for Non-IP Network Interfaces are set up with the HWSetup program and stored in 

the PC registry.  The Mcn Standard program will get that information from the registry when it 

runs. 

The settings for the IP Network Interfaces (HIB-IP) are set up in the MCNConfig program and 

saved in the database for the MCN system.  You will also use the settings stored in the system 

database to program the HIB-IP unit (through a COM port). 

Address 
This is used only for Non-IP Network Interfaces. 

It is a pointer to the Non-IP Network Interface that is set up with the HWSetup program. 

It will normally be "MCN1". 
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Group 
MCN Group Number for this module (Hex value 00-FE) 

This is shown only for HIB-IP units (which are configured in MCNConfig program). 

Module 
MCN Module Number for this module (Hex value 0-F). 

This is shown only for HIB-IP units (which are configured in MCNConfig program). 

MCN Group & Module Settings 
 

Warning: All Network Interfaces and MCN modules must have unique addresses.  

In addition, with regard to custom engineered systems with Routers and EXB Network 

Extenders, there may be specific Group & Module addresses that must be used with particular 

Network Interfaces, depending on their location in the MCN network. 

If you have a Custom Engineered System, be sure to consult your custom system configuration 

documentation for the proper setting for the Group & Module addresses for your Network 

Interfaces.   

Adding a HIB-IP and HIB-IP 8002 Network Interface  

Note: If you are using a PCLTA or HIB-232 Network Interface Skip this section and go to Hardware 

Resource Window Page 55.  

When you start to build a new system, the MCNConfig standard program will look in the registry to 

determine which Network Interface has been selected through the HWSetup program.  If you have set up 

a Non-IP Network Interface (such as a PCLTA, or a Non-Dial-Up HIB-232) in the HWSetup program, 

the MCNConfig program will find it and select it as the Network Interface for this system. 

If however you have a HIB-IP or HIB-IP 8000 in the HW Setup program, when the MCNConfig 

program opens the ‘Network Interface Type’ window will be shown as seen below on the left.  

    
 
Upon selection of the required type of HIB-IP interface the ‘HIB-IP Parameters’ window will appear.
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Enter the appropriate parameters for the HIB-IP or the HIB-IP 8000 unit: 

Name 
You may re-name the HIB-IP unit to change its default to a preferred name.  This is the name 

that you will refer to when you add hardware modules to the system.   

Address 
Enter a valid Class A, B, or C IP address for this unit. 

See details in the HIB-IP Hardware Reference Manual. 

Subnet Mask 
Enter the Subnet Mask for this IP address. 

See details in the HIB-IP Hardware Reference Manual. 

The HIB-IP Subnet Mask cannot be less restrictive than the following standard IP Class 

Subnet Masks 

 Class First Octet Standard Subnet Size Standard Subnet Mask 

 A 1-127 16,777,214 255.0.0.0 

 B 128-191 65,543 255.255.0.0 

 C 192-223 253 255.255.255.0 

 D 224-239 Multicast – Do not use. 

 E 240-255 Experimental – Do not use. 

The HIB-IP units can accept a subnet mask that is more restrictive (more 1's set in the Subnet 

Mask), but not less restrictive. 

Gateway 
If the Mcn Standard PC will be using an IP address that is in a different subnet than the HIB-IP, 

you must enter a Gateway IP address.  This is the IP address of the IP router that the HIB-IP 

will communicate to in order to talk to a PC that is on a different IP subnet.  The Gateway IP 

address must be on the same subnet as the HIB-IP unit. 

If the Mcn Standard PC and the HIB-IP are on the same subnet, you do not have to enter a 

Gateway address.   

See details in the HIB-IP Hardware Reference Manual. 

Group 
MCN Group address for the HIB-IP. 

Value:  00-FE Hex  

See Warning under Important:  MCN Address Setting on Page 28.  
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Module 
MCN Module address for PCLTAs and HIB-IP units.   

Value:  00-7E Hex Usually a HIB-IP will be set for a module number of 10 hex 

or above.  This leaves room for HIB-232 modules in the system, which are limited to 

Module Numbers 0-F. 

See Warning under Important:  MCN Address Setting on Page 28. 

HIB-IP Authorized PCs 

For system security purposes, the HIB-IP will only communicate with PCs that have been added to the 

Authorized PC list.  You may enter multiple IP addresses for Authorized PCs. 

To add an Authorized PC, Right-Click on the Authorized PCs list to bring up the menu. 

 

 

Select Append New. 

 

 A new PC will be entered. 

 Edit the PC Name (if desired). 

Right-Click here to add 

an Authorized PC. 

New Authorized 

PC Added. 
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 Edit the IP settings to match the PC you plan to use. 

 You can add additional Authorized PCs by right-clicking in the Authorized PC list. 

 Set up the parameters for the HIB-IP unit. 

 When you are finished entering Authorized PCs, click the OK button. 

 

Although you can enter multiple Authorized PCs in the HIB-IP database, the HIB-IP can only connect to 

one PC at a time.  If a second PC attempts to connect to a HIB-IP at the same time (even if it is in its 

Authorized PC list), it will be rejected. 

 

The HIB-IP unit will appear in the Network Interface window. 

 

It will then be associated with all the hardware modules (such as CIBs, AIBs, and IOBs). 

In the MCNConfig Standard program you can have only one Network Interface per system.  (If you need 

multiple Network Interfaces, like multiple HIB-IP units, you'll need the MCN Advanced Server 

software.) 

Programming HIB-IP and HIB-IP 8002 Units 

You must use the MCNConfig program to upload the system configuration parameters to the HIB-IP 

unit before you can use it.  

1. Be sure all the HIB-IP and Authorized PC parameters have been entered into the PC 

database as described above 

 

 For Legacy HIB-IP Modules with the DB9 Serial connector: 

2. Connect a Null Modem cable (CTI # 89-11314) between the PC and the Async Serial 

Programming connector on the HIB-IP. 

 

 

 

 

 

1 2 3 4

5

9876

ASYNC
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 For HIB-IP 8002 Modules with the USB connector:  

3. Connect a standard 4 pin A/B male USB Cable between the PC and the USB 

Programming connector on the HIB-IP 8002. 

 

 

 

 

 

               

 

4. Go to the Network Interfaces window and select the proper HIB-IP unit if more than one 

is shown. 

 
 

5.  Right-click on the HIB-IP unit and select "Load HIB" from the pop-up window. 

 

 

6. Click the "Program" button.  

 

Right-Click here  

on the HIB-IP  
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The application will automatically scan for all the available ports and display a list. 

 

 

After selecting the appropriate communications port and clicking ok, you will initially be 

required to enter the HIB-IP Password to authorize configuration changes to the module.  

There is a default Password which can be changed if needed. (See changing Password ) 

NOTE:  Default Password = “Initial-Password!”  

 

 

7. You can also read or verify the information in the HIB-IP by selecting the "View HIB" 

menu item from the previous pop up window.  This will read and display the 

configuration data within the HIB-IP unit. 

 

You may also refer to the HIB-IP Hardware Reference Manual S2-61173 for additional details on HIB-

IP Set up and Installation.
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Hardware Resource Window 

This is a list of hardware modules in the system.   

 

The Hardware Resource Window includes the following fields: 

NI 
Network Interface to use for this module. 

This is a drop-down field that will let you select from the defined Network Interfaces for this 

system (either PCLTA, HIB-232, or HIB-IP).  In the example above, there is a HIB-IP at the 

Communications Center connecting to the modules there and another at the Hilltop Water Tank. 

Group 
MCN Group Number for this module (Hex value 00-FE) 

Module 
MCN Module Number for this module (Hex value 0-F) 

Type 
Module Type from the following table: 

 

Module Type Description Receivers or I/O Blocks 

CIB Comparator Interface 8 

AIB Astrotac Comparator 
Interface 

8, 16, 24, 32, 40, 48, 56, 64 
(Depending on Bank setting) 

IOB Std 
(4 bits each) 

General I/O Controller 8 I/O Blocks  

IOB 2 Bit 
(2 bits each) 

General I/O Controller 16 I/O Blocks  

IOB 1 Bit 
(1 bit each) 

General Input Device 32 Input Blocks  

Banks 
Number of receiver banks (8 receivers per bank). AIB modules can have up to 8 banks.  All 

other modules have only 1 bank.  A drop-down list is provided. 

Location 
Typically refers to site name for this particular module. 

Free format text field for customer use.   

Not required for program operation. 

Can be used in error logging & emails 

Name 
Typically used to identify a particular module. 

Free format text field for customer use.  

Not required for program operation. 

Used in error logging & emails. 
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Channel 
The radio channel associated with this module.   

Drop-down field.   

Select one of the Channels from the Channel resource list. 

Can be used in error logging & emails 

Adding a Hardware Module 
 Add new hardware module with the New Module button.  

 
 

 Select a Hardware Type and hit Add. 

A new hardware module will be added to the bottom of the list.  It will have the next Group & 

Module number. 

 
 

 If this is an AIB module, enter the proper number of banks. 

 Enter the Location and Name. 

 Select a Channel from the drop--down menu 

 
 

Don't see any Channels in the list?  See Adding a Channel on page 58  for instructions on how to create 

channels. 
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Group & Module Numbers 
The program assigns the first module a Group:Module address of 00:0. 

If this is not correct for your system, you can change the Group & Module numbers. 

 

Group numbers are hex values that can be from 00 to FE. 

Module numbers are hex values that can be from 0 to F. 

 

The program will automatically increment the Module number from the last used number.   

When the Module number rolls over from F to 0, it will increment the Group number. 

 

Group & Module number combinations in any particular MCN system must be unique.  The Mcn 

Standard can access multiple separate MCN Networks with multiple HIB-IP units.  Separate MCN 

Networks are networks that are not tied together with EXB modules.  Separate MCN Networks can have 

modules with the same MCN Group & Module number combinations.   

Automatic Linking to Receiver Window  
When you add a new Hardware Module, the program automatically adds the appropriate number of 

Receivers or I/O Groups in the Receiver window. 

 

When you change the order of hardware modules in the Hardware window, the Receivers & I/O Groups 

follow in the Receiver Window. 

 

When you select a hardware module, the receiver window scrolls so that the first receiver or I/O group in 

that module is visible. 

Hardware Window Toolbar Buttons 

The following toolbar buttons will also function in the Hardware Window: 

         
 Append Insert Delete Copy Paste  

See Toolbars on page 44 for more details.  
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Channels Resource Window  

The Channels Window contains a list of radio channels used in the system.  It is used to logically group 

a number of hardware modules.  It can also be used to route email alerts to different email groups for 

different channels. 

  

Each channel has the following fields:  

Channel 
Channel name.  (e.g.:  Fire East, Countywide, Command, etc.)  Free format text field.  

Used in error logging & emails 

Email Group 
This is the group of Emails to send error alerts to for this channel.  

Drop-down field:  Select one of the Email Groups from the Email Group resource list. 

WD Multiplier   
The Watch Dog Multiplier configures the time interval for error monitoring and logging. 

Drop-down field:  Select a multiplier value from the list. 

This is a licensed feature that is only available and viewable with the System Performance 

Toolkit option. 

Adding a Channel 
 Add new channel with the New Channel button.  

The program will add a new Channel to the end of the list 

  
 

 Enter the Channel Name. 
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 Select an Email Group from the drop-down selection 

    

Don't see any Email Groups in the list?  See Adding an Email Group on page 60 for instructions on how 

to create channels. 

Channel Window Context Sensitive (Right Click) Menu  

By right-clicking on the Channel list, the following menu appears: 

  
  

 

 Sort: organizes the channels alphabetically. 

 Move Up and Move Down: will shift the selected channel up or down in the list. 

 Delete: will erase a channel.  

 Copy: will record the current selection to the clipboard. 

 Paste: will write the clipboard contents to a specified location. 

 Insert New Channel: will add a new channel at a specific location in the list. 

 Append New Channel: adds a new channel at the end of the list. 

 Watch Dog Alarm:  enables or Disable Watchdog flags for all receivers, and points, in the 

 channel. (Available only with the System Performance Toolkit ‘SPT’ Option.) 

 Export Text:  will export a text file copy, of the contents for this window. 

Channel Window Toolbar Buttons 

The following toolbar buttons will also function in the Channel Window: 

         
 Append Insert Delete Copy Paste Up Down Sort Alpha 

See Toolbars on page 44 for more details.
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Email Groups Resource Window 

The Mcn Standard program can send emails when it detects failures.  Emails can be sent to multiple 

recipients.  You can send email alerts to different groups of email recipients based on which channel has 

a failure.  An email window with two email groups is shown below 

  

If the Email Group window is not visible, use the menu command View … Email Groups to open it.  

Each Email Group has its own tab.  An “Email Group Tab” identifies a group of email addresses with a 

“Group Name”.  This is a free format text field.  (ex:  Police Techs, FD/EMS Techs).  Each entry in an 

Email group has the following fields:: 

Recipient 
Destination email (ex: TopTech@PD.GOV) 

There can be multiple recipients in an Email Group. 

Type 
Message type to use for messages to this email address. 

Select from:  To:, CC:, BCC: 

Adding an Email Group 
 Add a new Email Group with the New Email Group button.  

The Email Group Dialog box appears.  It will have a unique Email Group name. 

    
 

 Enter the desired Email Group Name and the Hold Off Time and click the OK button. 

   
 

Email Hold off Time 
In normal system operation, multiple failures can happen within a short time of each other. 

For instance, a "Stuck Microphone" will eventually cause all the receivers to go into Fail mode.  

Typically, all the receivers will fail within about 15 seconds of each other.  The system can aggregate 

these failures into one email instead of sending multiple emails.  When the program starts to send an 

email to an Email group, it will wait for the Email Hold off Time to expire before sending the email. 

When the timer times out, the system will send all the collected messages in one email. 
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Adding Email Recipients 
 

Once an Email Group is created, you can add email recipients. 

   
 

 Add a new Email Recipient with the New Email Recipient button 

If no Email Group is defined, this will add a new Email Group.  

 

   

 

 Enter the desired email address. 

   
 

 Continue the process to add more recipients to a group. 

   

 Adding Multiple Email Groups 

 Add additional Email Groups by using the New Email Group button or right click on the 

Current Group Tab: Then enter the preferred Group name. 

 

    
                    Default Name.      Edit Name. 
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   Finished. 

 

 

 Add recipients with the New Recipient button. 

  

Email Group Context Sensitive (Right Click) Menu 
The following menu functions are available with a right click on the Email Group tabs. 

  

Email Recipient Context Sensitive (Right Click) Menu 
The following menu functions are available with a right click in the Email Recipient list. 

 

  

Email Group Window Toolbar Buttons 
The following toolbar buttons will also function in the Email Groups Window: 

         
 Append Insert Delete Copy Paste Up Down Sort Alpha 

See Toolbars on page 44 for more details. 
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Receivers Resource Window 

The Receivers Window shows: 

 The site names for all the receivers in the system.   

 Input/Output groups for I/O modules 

It is based on the modules defined in the Hardware Window.   
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Fast Navigation in Receiver Window 
The Receiver Window is linked to the Hardware Window.  Clicking on a module in the Hardware 

Window will bring up the first receiver of that module in the Receiver Window. 

Each entry in the Receivers Window has the following fields: 

NI 
Network Interface for this hardware module.  This is a read-only field and is defined in the 

Hardware window. 

Grp:Mod 
The MCN Group & Module number for the hardware module.  This is a read-only field defined 

in the Hardware Window.  The order of modules follows the module order in the Hardware 

window. 

Type 
The Module Type (CIB, AIB, IOB Std, IOB 2 Bit, IOB 1 Bit, etc.) for the hardware module.   

This is a read-only field that is controlled in the Hardware Window 

Channel 
The radio channel for the hardware module.  Read-only field (defined in Hardware list). 

Rx 
The Receiver Number for this receiver.  This is a sequential number for a particular receiver 

within its module.  Read-only field.  The maximum receiver number in a module is based on the 

Bank number in the Hardware list. 

 

Name 
Receiver site name (ex:  North Tower, VA Hospital, etc.). Free-format text field.  Change the 

Receiver Name by selecting the cell and typing in the name. 

You can also cut & paste descriptions from Excel.  See Using the Clipboard from other 

Applications on Page 90. 

Description 
Free format text field for general customer use.  Many customers use this field to store an 

identifier for the leased line, microwave channel, or T1 channel bank and channel number for 

this receiver.  This field is not required for program operation. Can be used in error logging & 

emails 

You can also cut & paste descriptions from Excel. See Using the Clipboard from other 

Applications on Page 90 for more details. 
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Sub-Device 
This is an available feature of the Standard software, when the Sub Comparators under the 

View Menu is enabled. 

It allows a sub device to be linked to a particular Receiver.  

 

Display Table 
This is the mapping table to use for this receiver (or alarm point). The Display Table determines 

how the input bits from the hardware modules are mapped to the status display.   

If you have all receivers, you will probably only use the "Comparator" table.  This maps the 

inputs to the standard "Vote", "Rx", "Dis", and "Fail" statuses.   

If you have any Input / Output groups which can be used for things such as microwave or site 

alarms, you will need to select a different Display Table (such as "Generator", "Door" or 

"Power") for those points.   

 

 
 

This is a drop-down field.  Select one of the Display Tables from the drop-down list. 

 
 

Receiver Window Context Sensitive (Right Click) Menu 

The following menu functions are available with a right click in the Receiver list. 

 

Receiver Window Toolbar Buttons 
The following toolbar buttons will also function in the Receiver Window: 
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 Delete Cut Copy Paste 

See Toolbars on page 44 for more details. 

Since the Receiver & I/O Group rows are controlled by the Hardware Window, functions such as 

Append, Insert, Sort, Up, & Down are not available in this window. 

Alarms and Display Tables 
You can configure "sticky" alarms in the system through the Display Tables.  Alarms will be displayed 

in the Alarm tab of the System events (Log) Window.  They will remain in that window until 

acknowledged and reset.  Alarms can also generate sounds when they go into the active state.  See the 

Alarm Display – Log Tab / Alarms Tab section on page 127 for details on Alarm operations, and the 

States Tab States Tabsection starting on page 68 or instructions on how to enable alarms in the Display 

Tables. 

The Display Tables window allows you to define various Display Tables for I/O devices.  The Display 

Tables map the input bit values from the devices to the text and colors to be displayed on the screen. If 

there is a standard Display Table for your receivers or I/O types, you probably will not need to modify 

the data in the Display Tables window. 

The Display Table types may vary depending on the version of the software package, but a number of 

Display Tables are pre-defined: 

 Comparator 

 Generator 

 Door 

 Power 

 Fail 

 Temperature 

 Alarm 

 Binary Table 

From the menu, select View / Display Tables. 
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Display Table Tab Properties 

To display the overall properties for a Display Table, Double-Click on its tab. 

 

 

From the Display Table window you can change the following items  

for this Display Table: 

 

-Display Table (tab) name 

-Number of input bits 

-Offline Text & Colors (displayed when a module is offline) 

- Logging flag for the Off-Line state. 

-Busy State indicator (for legacy modules) 
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States Tab 

 

Each Display Table has a series of states based on the values of the input bits.  In addition to the 

specifically defined input states, each Display Table has two special states: 

 Offline. This is displayed when a module is offline.  It is configured in the Display Tab 

Properties window. 

 Default: This is the first state in the table (with all dashes).  

It is used for any of the conditions not shown in the table.  

 

The fields in the States tab are: 

State Bit Names 
This field shows the functions of the input bits as received from the hardware.  Bit 0 (lsb) is the 

right-most bit in the State Lines. 

Since the comparator modules have fixed bit assignments, the Comparator Display Table has 

fixed bit names.  Bits used by other I/O devices will be user-defined based on their function.  

The Bit Names in these Display Tables are user-assignable. 

State Input Bits 
Each Status line has a series of input bits that corresponds to its state.  This is a trinary (binary 

with don't care) field that defines the state. 

Trinary Values 

0 Not active 

1 Active 

- Don't Care 

Don't Care bits 

A state that has a dash "-" in a bit position will be active whether that bit is either active or 

inactive.  For example, in the standard Comparator Display Table, the Vote state has a Don't 

Care for the Rx bit.  The Vote status will be indicated whether or not the Receive bit is active. 
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State Priority 

The states in the table have the following priority: 

1. Off-Line If the module is off-line. 

2. Numbered States Lowest number has the highest priority. 

3. Default State  If no other state is found to match the input bits. 

If an input value is covered by two defined states, the lower numbered state will be displayed. 

State Text & Color Field 
This is free-format text to be displayed when this state is active. 

Foreground and background colors can be defined for each state. 

Sound Field 
This field is the .WAV sound file to be played whenever any input changes to this state.  This 

field is typically used only for alarm conditions.   

Sounds are played only if the state is also logged.  If you want a sound to play for a state entry,  

make sure the Log field is set to 1.   

Email Field 
This is a flag to determine whether or not to log this state to email.   

 0 = Don't log 

 1 = Log  

If the Logging flag is set to 1, an email log entry will be generated whenever an input goes into 

or out of this state. 

Log Field 
This is a flag to determine whether or not to log this state (to screen, printer, or disk).   

 0 = Don't log 

 1 = Log  

If the Log flag is set to 1, a log entry will be generated whenever an input goes into or out of 

this state. 
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Editing the fields 

Input Bit Values: Click in the bit value field to edit   

You can either enter a value (0,1,-) or use the drop-down list. 

You may need to widen the columns to see the drop-down list properly. 

 

State Names Double click on the State name.   

A State Editor dialog box will appear. 

Enter the appropriate State Text. 

State Color From the State Editor dialog box, hit the 

Foreground or Background button. 

Select the appropriate color. 

 

Drag column line to widen column 

Input Bit Drop-Down List 



MCN Config Program:  Display Tables Window 

 71 S2-61043-250 

Sound To select a sound, double click in the Sound cell. 

Select the appropriate WAV file from the State Sound Definition window. 

 

 

 

Alarms Flag Click in the field. 

Type in "Y" or "N" or use the Drop-Down List. 

 

Email Flag Click in the field. 

Type in "Y" or "N" or use the Drop-Down List. 

 

Log Flag Click in the field. 

Type in "Y" or "N" or use the Drop-Down List. 
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State Table Verify 
Since the entries in the Display Table are free-format (and also allow Don't Care bits), it's easy 

to build a Display table that doesn't work like you thought it would. You can therefore verify 

how the MCN software will interpret the table by clicking the Verify button on the bottom right 

corner of the Display Table window.  This will bring up a Display Table Verification window; 

which will show the states that result from each possible binary input value. 
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Display Table ‘Right Mouse Click’ Menu 
Clicking the right mouse button over a cell will offer the following options: 

Move Up 
Moves a row up one position 

Move Down 
Moves a row down one position 

Delete Row 
Deletes a row 

Delete Sound 
Deletes the sound entry for the selected row. 

Copy 
Copies the highlighted cell(s) to the clipboard.  Does not work with entire rows. 

Paste 
Pastes the clipboard to the current cell.  If more than one cell is on the clipboard, the additional 

cells will be pasted to cells to the right. 

Insert 
Inserts a blank row at the current location 

Append 
Appends a blank row to the end of the Display Table 

Export Text 
Will export a text file copy, of the contents for this window.   
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Editing Bit Names 

To edit the Bit Names for a Display Table, Double Click on the Bit Name. 

The Bit Names for the Comparator Display Table are fixed and cannot be edited. 

 

 

Mouse Actions Tab 

Four(4) mouse button actions are defined for each Display Table: 

 Left Mouse Button Down (Press)  

 Left Mouse Button Up ( Release) 

 Right Mouse Button Down (Press) 

 Right Mouse Button Up ( Release) 
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Each Mouse Event Line contains the following fields: 

Button 
Describes the mouse event 

 

Type 
This is the action that will be taken when this mouse event occurs. 

Choices are: 

 -Unused This Mouse Event does not generate an vent  

 

 -Set This Mouse Event explicitly sets defined bits to the states shown. 

  ("0"bits are set to 0, "1" bits are set to 1, "-" bits are left alone) 

 

 -Toggle  This Mouse Event toggles the state of all the bits marked with a "1". 

Bits 
The bit names are taken from the States tab.  They can be either "0", "1" or "-". 

See the Type field for description of how each of these bits is handled. 

 

Note that the bits that appear here may not all be output (control) bits, due to the actual device 

being controlled.  In the example above, the only valid output bits are Vote and Disable. 

Editing the fields 

Type To edit, click in the field. 

Select the type with the Drop-Down menu. 

Bits To edit, click in the bit value field. 

You can either enter a value (0,1,-) or use the drop-down list. 

You may need to widen the columns to see the drop-down list properly. 

 

SubDevice Tab  
 
The SubDevice Tab that is displayed below is only available when sub-comparators are enabled under 

the View Menu. It must be configured for use in conjunction with the Master Comparator option that 

passes the Master Vote down to the Sub-Comparator.  For specific details about this Tabs’ functions and 

options see Page 102.  For a deeper understanding about the Application, Configuration and 

Implementation of Master-Sub Comparators, refer to the Section title ‘MCNConfig Program:Master-

Sub Comparator Configuration’ on Page 93. 
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MCNConfig Program:  Display Windows 

Display windows are the screens that you build for the Mcn Standard program.  Each Display Window 

can contain multiple Tabs and multiple channels. 

In this section, we will discuss how to: 

 Add a new Display window 

 Add Labels 

 Add Receivers (and I/O groups) 

 Add Tabs 

 Move & Modify Labels & Receivers 

Adding a New Display Window 

 

 Add a new Display Window with the Add Display Window button.  

   
 

 Change the File Name, Title, Rows, and Columns as desired and click the OK button. 

  

  

 A blank Display Window with one Tab will appear 
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Adding Labels to the Display Window 

Labels are used to identify and differentiate between multiple channels, if displayed in one tab. 

 

 Add a new Label in the Display Window with the Add Label button.  

 

 In the Label Editor Dialog Box, enter the desired Right & Left Labels.   

The left label will appear over the receiver names.   

The right label will appear over the status column. 

 

 You can also change the Foreground (text) and Background colors at this time. 

If the Link Colors box is checked, both the left & right labels will have the same color set. 

 

 Hit OK when you are done. 

The label will be placed on the screen. 

 

The properties for display window label, may be view by right clicking on the Label cell and selecting 

properties.   
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Adding Receivers & I/O Groups to the Display Window 
 

 Add new Receivers or I/O Groups in the Display Window using the Add Receiver button from 

the Toolbar on the left.  

 

 An Add Receiver dialog box will appear. 

This is similar to the Receiver Window, but it has additional buttons. 

 
 

 Select the receiver or I/O group that you what to add, and click the Add button. 

 
 

 An Add Receiver dialog box will appear. 

This is similar to the Receiver Window, but it has additional buttons. 
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 Press the Add button for each additional receiver or I/O groups you wish to add. 

 
 

 The program will continue adding receivers to the selected column in the Display Window. 

If it reaches the bottom of a column, it will wrap to the top of the next column. 

 When you are finished adding a range of receivers or I/O groups, click the Close button. 

 
 

 Move to the position for the next receiver and repeat until you have all the receivers added. 

 

Adding a block of receivers or I/O points to the Display Window 

 Press the Add Receiver button. 

 In the Add Receivers dialog box, select a block of receivers 
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 Hit the Add button.  

This will add the receivers all at once,.. 

 
 

Automatic Linking to Receiver Window  

As you select different cells in the Display Window, the receiver window scrolls so that that receiver or 

I/O group is visible. 

Verifying Receiver Placement 

Many systems have receivers from many channels at each site.  Since only a Receiver site name or I/O 

Group name is present in the Display Window, it is not readily apparent which particular receiver or I/O 

point is in a particular cell.  You can quickly check the contents of the Display Window by doing the 

following: 

 

 Open the Display Window 

 Open the Receiver Window. 

 Select the first Receiver in the Display Window. 

 The Receiver Window will show which receiver is at that cell. 

 Use the arrow keys to move through all the receivers on the Display Window. 

 Repeat for the other tabs in the Display Window. 

Adding Display Tabs 

 Press the Add Tab button. 

 Enter the name for the new tab. 

A blank grid will appear. 
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 Add Labels, Receivers, and I/O Groups for that tab. 

 
 

Deleting Display Tabs 
 Right-click on the tab and select Delete Tab from the pop-up menu. 
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Changing Display Window Parameters 

You can change the following properties of a Display Window. 

 Display Window Title 

 Number of Rows 

 Number of Columns 

In this example, we want to get rid of the unused fourth column. 

 

 Press the  Display Window Properties  button. 

 
 

 Change the number of Columns from 4 to 3. 

(You could also change the Title or number of rows at this point.) 

 

 Hit the OK button. 

 
 

The number of columns is reduced for all tabs.  If you reduce the grid size, you may lose receivers or 

labels that fall outside the new range.  Receivers and I/O Groups are still in the Receivers Window; they 

just disappear from the Display Window. 
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Changing Column Widths in Layout Mode 

You can change the column width for the resulting Display Window.  To do this, you must go into 

Layout Mode. 

 Right-click in the grid and select Layout Mode. 

 

The grid will turn gray, indicating it is in Layout Mode. 

 
 

 Move the cursor over a column separator line.  The cursor will turn into a double-headed arrow. 
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 Press the left mouse button and drag the column to the proper width. 

 Repeat with the right column separator for the Status column. 

 
 

Column Width Note 

All the Receiver columns are the same width. 

All the Status columns are the same width. 

Changing a column width will change the width of all the similar columns on all tabs. 

 

 Right-Click in the grid and select Edit Mode. 

 

The window will return to Edit mode. 
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Changing Label Text & Colors 

You can change a Label text or color by doing one of the following: 

 Double click on a Label. 

 

 Right-Click on the Label and select the Label menu item. 

 

 Select a Label cell and press the New Label toolbar button. 

 

The Label Edit dialog box will appear. 

 
 

 

 You can edit the left & right text. 

 You can change the Foreground or Background color of the labels by hitting the Foreground or  

Background button below the label 

 
 

 Select a color and hit OK 

 If you want a color not shown, hit the Define Custom Colors button. 

 

When the Link Color box is 

checked, the left & right labels 

will have the same colors.  

When changing the color of a 

series of labels, press the Last 

Color button to set current label 

to the last color used. 



MCNConfig Program:  Display Windows 

 86 S2-61043-250 

Moving Receivers & Labels in the Display Window 

This section covers single column cuts & pastes.  See the next section for cutting & pasting  multi-

column selections 

To move Labels, Receivers, or I/O Groups: 

 Select the items to move 

 Right click and select the Cut menu item.  

(Alternately, use the Cut toolbar button)  

 
 

This cuts the selection and places it in the clipboard. 

 Move to the desired location  

Right click and hit Paste.  

(Alternately, use the Paste toolbar button)  

This pastes the items into the new location. 
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Cutting & Pasting Multiple Columns 

Cutting and pasting occur in the following order: 

1. Across (left to right) 

2. Down 

Copying the range shown  

puts the cells into the clipboard 

in the following order: 

1. Label 1 

2. Label 2 

3. Glendale  Rx 

4. Univ Cntr  Rx 

5. Mercy Hosp Rx 

6. HQ  Rx 

 

 

Pasting the clipboard to a single cell or column… 

  

Results in a single column 
(probably not the result you wanted.) 

Pasting the clipboard to a range with the same number of columns … 

  

Preserves the shape of the range of cells. 
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Pasting a Row of Receivers Directly from the Receiver Window 

All the examples shown assume you have a system with many receiver sites and want to look at the sites 

in a column arrangement.  If you have a trunking system with many channels but just a few sites, you 

may want to display each channel as a row with the sites going across from left to right. 

You can do this by cutting and pasting a group of receivers directly from the Receiver Window into the 

Display Window. 

1. From the Receiver Window, highlight a group of receivers and Copy to clipboard. 

 

 
 

2 Go to the Display Window. 

Move the cursor to the starting position for the row of receivers. 

Highlight the row and Paste the clipboard to the screen. 

 
 

3 The receivers are pasted into the Display Window in a horizontal row: 

 
 

4. A 10-Channel 5-Site System 
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Display Window Tools 

Display Window Tab Context Sensitive (Right Click) Menu 

The following menu functions are available with a right click on a Display Window Tab. 

 

Display Window Context Sensitive (Right Click) Menu 

The following menu functions are available with a right click in the Display Window Grid. 

 

Quick Receiver & Label Changes 

You can double-click on a Receiver or Label cell to change it.  The “Add Receiver” or “Add Label” 

dialog box will open, allowing you to make changes to the cell. 

Display Window Toolbar Buttons 

The following toolbar buttons will also function in the Receiver Window: 

     
 Delete Cut Copy Paste 

Since the Display Window uses a fixed grid, functions such as Append, Insert, Sort, Up, & Down are not 

available in this window. 
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Using the Clipboard from other Applications 

Many people keep system data in other applications, such as Excel.  You can cut and paste some of this 

data from the other application into the MCNConfig program to save typing time.  

Various fields in the MCNConfig database have special properties and thus have restrictions as to 

whether or not you can paste data from other applications or other windows.  See the following section 

for restrictions. 

Or …. 

Copy (Ctrl-C) a column of  

Names in Excel 
And Paste (Ctrl-V) them into the 

MCNConfig Hardware List 

Copy Receiver Site 
Names and Line 

Numbers from Excel 

Into the MCNConfig Receiver List 
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Restrictions on Using the Clipboard 

Various fields in the MCNConfig database have special properties and thus have restrictions as to 

whether or not you can paste data from other applications or other windows.   

In all List Windows, any column that is highlighted in gray is a static column and cannot be changed in 

that window.  

You cannot copy items into a drop-down field, except items from an identical drop-down field. 

Module List Window: 
Group Field This field accepts only hex data from 00 to FE. 

You can paste data from the clipboard, but it must be hex data in this range. 

For every non-valid entry, you will see an error dialog box. 

Module Field This field accepts only hex data from 0 to F. 

You can paste data from the clipboard, but it must be hex data in this range. 

For every non-valid entry, you will see an error dialog box. 

Type This is a drop-down entry that limits the data to pre-defined hardware types. 

You cannot paste into this column. 

Banks Bank numbers are limited by the Module Type used. 

CIBs can have only 1 bank.  AIBs can have up to 8. 

You can paste into this column for AIB modules.  Each entry must be between 1 & 8. 

You will get a warning if you try to reduce the number of banks in an AIB. 

Location This is a free-format text field.  You can paste text into this column.  

Name  This is a free-format text field.  You can paste text into this column. 

Channel This field allows entry of only channels defined in the Channel List window.   

You can cut & paste from one part of this column to another part. 

You cannot paste other types of data into this column. 

Receiver List Window 
Name This is a free-format text field.  You can paste text into this column. 

Description This is a free-format text field.  You can paste text into this column. 

Table This field allows entry of only display tables defined in the Display Table window.   

You can cut & paste from one part of this column to another part. 

You cannot paste other types of data into this column. 

Channel List   
Channel This is a free-format text field.  You can paste text into this column. 

Email Group This field allows entry of only Email Groups defined in the Email Groups window.   

You can cut & paste from one part of this column to another part. 

You cannot paste other types of data into this column. 

Email Group   
Recipient This is a free-format text field.  You can paste text into this column. 

Type This field allows entry of only Email Types (To: & CC:). 

You cannot cut & paste from one part of this column to another part. 

You cannot paste other types of data into this column. 
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Display Window (Screen Layout) 
All Cells The cells require either: 

 -Left & Right Labels or 

 -Valid Receiver or other I/O Function Block References. 

You can paste receivers from Receiver List window. 

You can cut & paste a range of labels & receivers from a Display Window. 

You cannot paste other types of data into these cells. 

Pasting a Column of Receivers from the Receiver Window into the 
Display Window: 

(Channels with a large number of sites) 

1. From the Receiver Window, highlight a group of receivers and Copy to clipboard. 

 
 

2 Go to the Display Window. 

Move the cursor to the starting position for the column of receivers. 

Paste the clipboard to the screen. 

  
 

The receivers are pasted to the Display Window in a column. 
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MCNConfig Program:Master-Sub Comparator 
Configuration   

Configuration Overview 

MCNRCD for Windows can handle systems in which comparators are arranged as Master Comparators 

and Sub Comparators.  A group of comparators that are in a Master-Sub configuration can be depicted as 

in the following diagram.   

 

 

In this case, eight receivers at Location A are fed into Sub Comparator A.  Likewise, eight receivers at 

Location B are fed into Sub Comparator B, and additional locations may have comparators with their 

own receivers.  The selected audio from each of these locations is fed to the Master Comparator at the 

Central Location.  Finally, the selected audio from the Master Comparator is sent to the Dispatch 

Consoles.  Each one of the comparator chassis would have a CIB module connected to it. 
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Equipment-Centric View 

The following diagram shows an equipment-centric view of the system described above.  It has the 

following: 

 A display for each receiver for each Sub Comparator 

 A display for the Master comparator, showing each of the Sub Comparators feeding it. 

It does not use the special Master-Sub Comparator features in MCNRCD (discussed below). 

    

                        

  Master Comparator           

  Sub A Rx           

  Sub B Rx           

  Sub C Vote           

  Sub D Rx           

              

  Sub Comparator A Sub Comparator B Sub Comparator C Sub Comparator D-1 Sub Comparator D-2   

  Site 1   Site 9   Site 17 Rx Site 25   Site 33     

  Site 2 Rx Site 10   Site 18 Vote Site 26   Site 34     

  Site 3 Rx Site 11 Rx Site 19 Rx Site 27 Vote Site 35 Dis   

  Site 4 Vote Site 12   Site 20   Site 28 Rx Site 36     

  Site 5 Rx Site 13   Site 21 Rx Site 29   Site 37     

  Site 6 Rx Site 14 Vote Site 22   Site 30   Site 38     

  Site 7   Site 15 Rx Site 23 Rx Site 31   Site 39     

  Site 8 Dis Site 16   Site 24   Site 32   Site 40     

                        

            

The above display indicates: 

 The Master Comparator is voting Sub Comparator C. 

 There are other Vote indications on Sub A, Sub B, Sub C, and Sub D.  

Each comparator is shown as an independent comparator (although they are actually physically 

connected in a Master-Sub configuration). 

To determine which audio is being heard by a dispatcher, you would have to go through a two-stage 

process: 

1. Determine that the Master Comparator is voting Sub Comparator C 

2. Sub Comparator C is voting Site 18 

In other words, there is no immediate direct indication of which site’s audio is being heard by the 

dispatcher.  The Votes on Sites 4, 14, and 27 from Sub Comparators A, B, & D are not the signal being 

used by the Master Comparator at the moment, even though they have a “Vote” indication.  This can be 

very confusing to a dispatcher 

However, the equipment-centric display could be useful for a technician who is troubleshooting the 

system.  If, for example, a Vote is stuck on a Sub Comparator, it would be readily apparent on this 

screen. 
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Virtual Comparator View 

A dispatcher is not necessarily concerned with the details of master and sub comparators.  They would 

only need to know which receiver is the one that is providing the audio.  A System view or Virtual 

Comparator view is shown below. 

                          

  Sub Comparator A Sub Comparator B Sub Comparator C Sub Comparator D-1 Sub Comparator D-2   

  Site 1   Site 9   Site 17 Rx Site 25   Site 33     

  Site 2 Rx Site 10   Site 18 Vote Site 26   Site 34     

  Site 3 Rx Site 11 Rx Site 19 Rx Site 27 Rx Site 35 Dis   

  Site 4 Rx Site 12   Site 20   Site 28 Rx Site 36     

  Site 5 Rx Site 13   Site 21 Rx Site 29   Site 37     

  Site 6 Rx Site 14 Rx Site 22   Site 30   Site 38     

  Site 7   Site 15 Rx Site 23 Rx Site 31   Site 39     

  Site 8 Dis Site 16   Site 24   Site 32   Site 40     

                        

            

This view shows: 

 A display for each receiver for each Sub Comparator 

 No indication for the Master comparator 

 A Virtual Comparator with 40 inputs. 

 A single green "Vote" indication, showing the receiver being heard by the dispatcher. 

 "Rx" indications for the receivers that are voted in the Sub Comparators but are not voted in the 

master. 

The Virtual Comparator view uses a special Master-Sub Comparator feature of the MCNRCD software, 

and allows the use of a special Sub-Comparator display table. The Master-Sub feature in the MCNRCD 

software allows votes on sub comparators that are not being used by the Master Comparator to be 

modified to display “Rx” instead of “Vote”.  They will be modified to display “Rx” since their sub 

comparators are not the voted audio at the Master Comparator.  In this display, there is an immediate 

direct indication of which site’s audio (Site 18) is being heard by the dispatcher. 
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Enhanced Virtual Comparator View 

An alternate Enhanced Virtual Comparator view is shown below: 

    

                        

  Sub Comparator A Sub Comparator B Sub Comparator C Sub Comparator D-1 Sub Comparator D-2   

  Site 1   Site 9   Site 17 Rx Site 25   Site 33     

  Site 2 Rx Site 10   Site 18 Vote Site 26   Site 34     

  Site 3 Rx Site 11 Rx Site 19 Rx Site 27 Rx V Site 35 Dis   

  Site 4 Rx V Site 12   Site 20   Site 28 Rx Site 36     

  Site 5 Rx Site 13   Site 21 Rx Site 29   Site 37     

  Site 6 Rx Site 14 Rx V Site 22   Site 30   Site 38     

  Site 7   Site 15 Rx Site 23 Rx Site 31   Site 39     

  Site 8 Dis Site 16   Site 24   Site 32   Site 40     

                        

            

This view: 

 Is similar to the Virtual Comparator View 

 Shows only one green "Vote" indication ( the receiver whose audio is being used) 

 Shows an "Rx V" indication for the sites that are voted in the Sub Comparators but are not 

voted in the master. The "Rx V" indication is shown in gray, so as not to be confused with the 

green "Vote" indication. 

This provides a bit more information than the standard Virtual Comparator view.  It also provides 

feedback to the user when he tries to Force-Vote a receiver.  He will get an indication that the CIB 

received his command (by the "Rx V" status) even if the master comparator does not vote the receiver's 

Sub Comparator. 

The Virtual Comparator and Enhanced Virtual Comparator views can be implemented with standard 

Display Tables that are shipped with the Master-Sub Comparator option.  You may modify those display 

tables or create your own display tables to suit your system's needs. 

 



MCNConfig Program:  Master-Sub Comparator Configuration 

 97 S2-61043-250 

Implementing the Virtual Comparators 

To implement either of the above “Virtual Comparator” displays, the following steps should be taken: 

1. Enable Master-Sub features of the MCNRCD for Windows software. 

2. Setup the Network Interface, Channels, Hardware, and Receivers windows as instructed 

earlier in this manual 

3. Assign Display Tables for the Master and Sub Comparator receivers and  

Define the SubDevices for each channel of a Master Comparator. 

4. Design the Display Window for the Virtual Comparator. 

Optionally, if you want to customize the Master or Sub-Comparator display tables: 

5. Customizing Display Tables for Master and Sub Comparators. 

 Each of these steps will be explained in detail in the following sections.   

1. Enable Master-Sub features 

From the View menu, click on Enable Sub-Comparators to display a “check mark” next to this menu 

item as shown below.  This provides access to Master-Sub features of the MCNRCD for Windows 

software. 
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2. Setup Network Interface, Channels, Hardware and Receiver 
windows 

The Network Interface, Channels and Hardware windows for this example system should look like the 

following.  The generation of these tables has been explained in previous sections of this manual, and 

will not be discussed in detail here. 

 

 

 

 

 

 

The Receivers window will be discussed in the next section. 
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3. Assign Display Tables and Define the SubDevices 

A.  Assign Display Tables 

In the “Receivers” window, double-click in the Display Table column and select the proper Display in 

the cell for each receiver as illustrated by the following Table Entry. 

Receivers Display Table 

Master Comparator "Master Comparator" 

Sub Comparator "Sub Comparator"  (for Virtual Comparator) 

"Sub Comparator Enhanced" (for Enhanced Virtual Comparator)  

 

 

 

 

B.  Assign Sub Devices for each receiver in the Master Comparator 

In the “Receivers” window, a “SubDevice” column will be displayed as shown below (only with Master-

Sub features enabled as indicated above).   

1. For each receiver of a Master Comparator, double-click its cell in the “SubDevice” column to 

display the following “Select SubDevices” window.   

2. From the list of available SubDevices on the left side, “Add” the appropriate receivers to the 

right side of this window.   

3 A:  Assign Display Tables for Master & Subs 

3 B:  Define SubDevices for each receiver in Master comparator 
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For the first Master Comparator receiver that is fed from Sub Comparator A, the “Select SubDevices” 

window should look like the following.  

 

Click the OK button to close this window.   

Notice that the cell in the “SubDevice” column of the “Receivers” window for this receiver is now set to 

“Yes”. 

4. Design the Display Window for the Virtual Comparator 

As shown in the following Display Window, all 40 site receivers of the Sub Comparators are included in 

the display.  Note that the Master Comparator is not shown in this Virtual Comparator view. 
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5. Customizing Display Tables 

In the “Display Table” window, several types of devices have been predefined, including Comparator, 

Generator, Door, and others.  Each device type has its own tab across the top of this window.  The 

Master-Sub Comparator Option adds the following Display Tables: 

 Master Comparator 

 Sub Comparator 

 Sub Comparator Enhanced 

If these display tables suit your application, you can skip this section.  If you need to modify them, read 

on. 

Sub Comparator Display Table 

The Sub Comparator display table States tab is shown below: 

 

This Sub Comparator States table has several basic differences from the basic Comparator display 

table: 

 The Steer bit is a Don't Care (we're not using Transmitter Steering in this system) 

 An additional Master (Master Vote) bit has been added (leftmost bit). 

 The Vote state requires the Master bit (Master Vote) bit to be set (State 6) 

 If the Rx bit is set and the Master (Master Vote) bit is not set, the display will show "Rx", even 

if the Vote bit (Sub Comparator Vote) is set (State 5) 

The Master (Master Vote) bit is inherited from the Master comparator.  It is only set when the Sub 

Comparator is voted in the Master Comparator. 
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Master Comparator Display Table 

States Tab 

The Master Comparator display table States tab is shown below: 

 

This Master Comparator States table has a basic difference from the basic Comparator display table: 

 The Steer bit is a Don't Care (we're not using Transmitter Steering in this system) 

SubDevice Tab 

The SubDevice tab has been added in the Master-Sub Comparator option.  The Master Comparator 

display table SubDevice tab is shown below: 

 

The SubDevice tab for the Master Comparator has the following items that are used to pass the Master 

Vote down to the Sub Comparator: 

 Bit Mask for the Vote bit is a 1.  This is the bit that will be passed on to the Sub Comparator 

devices. 

 The Nudge field is set to 5.  This tells the program how far to move the inherited bit(s) in the 

SubDevice.  This number will depend on the SubDevice. 
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Bit Mask and Nudge Fields 

The Bit Mask fields indicate which bit(s) is (are) used to pass to the SubDevice.   

In general, the "Nudge" field should be the number of native bits in the destination SubDevice Table.  (If 

there are Multi-dependencies – multiple Master Comparators for each Sub Comparator – you will need 

to specify special nudge values.) 

 

Master Bits  Steer Rx Dis Vote Fail 

Mask  0 0 0 1 0 

Masked     Vote  

Compressed 
& Shifted 

     Vote 

       

Nudged (5) Master 
Vote 

     

Sub 
Comparator 
Bits 

Master 
Vote 

(Inherited) 

Steer Rx Dis Vote Fail 

 

 

The best way to understand how to set the Bit Mask and Nudge fields is to consider how the MCNRCD 

program processes the bits from the Master comparator as shown above: 

1. The program masks out all bits that have a "0" in the mask field. 

It passes only those bits that have a "1" in the Bit Mask field (Vote in this case) 

2. All the bits with a "1" in the bit mask field are compressed and shifted to the right to fill the Least 

Significant Bits (right hand bits).  In the above example, there is no compression going on – only 

shifting.  The compression comes in when there are multiple non-contiguous mask bits set to "1".  In 

that case, the program compresses the bit field by deleting all the unused bits.  This is shown in the 

Multi-Bit Mask section on the next page. 

3. The Compressed & Shifted Bits will be nudged to the left by the number specified in the "Nudge" 

field (5 in this case). 

4. The Nudged bit will be passed to all the receivers in the Sub Comparators. 

5. The resultant bits (the inherited bit plus the "native" Sub Comparator bits) will be used in the Sub 

Comparator Display Table to determine the status to display.   

 

Inherited bit "Native" bits from Sub Comparator CIB 
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Multi-Bit Mask 

There may be times in which you need multiple bits from a master device to be passed to a sub device.  

The following table illustrates how to do this. 

If, for example, you wanted to pass the "Rx" and the "Vote" bits from the Master comparator to the Sub 

Comparator, you would set the mask as shown:   

 

Master Bits   Steer Rx Dis Vote Fail 

Mask   0 1 0 1 0 

Masked    Rx  Vote  

Compressed 
& Shifted 

     Rx Vote 

        

Nudged (5) Master 
Rx 

Master 
Vote 

     

Sub 
Comparator 
Bits 

Master 
Rx 

Master 
Vote  

Steer Rx Dis Vote Fail 

 

 

For Multi-Bit Master-Sub Comparator, the MCNRCD program processes the bits from the Master 

comparator as shown above: 

1. Both the "Rx" and "Vote bits have a "1" bit set. 

2. The "Rx" & "Vote" bits are compressed (unused bits are deleted) and shifted to the right to fill the 

Least Significant Bits (right hand bits) 

3. The Compressed & Shifted Bits will be nudged to the left by the number specified in the "Nudge" 

field. (5 in this case) 

4. The Nudged bits are passed to all the receivers in the Sub Comparators. 

(Note that this is just an example of what could be done with multiple bits to show how multiple bits are 

handled.)  

Inherited bits "Native" bits from Sub Comparator CIB 
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Multi-Level Inheritance – Sub-Sub Comparators 

The Master – Sub Comparator feature allows you to pass bits down from a master device to a sub device 

as shown above.  You can create multi-level systems as shown below: 

 Master Comparator 

  Sub Comparator  

   Sub-Sub Comparator 

You can only pass down native bits, not inherited bits.  In the example above: 

 The Sub Comparator could pass its own Vote bit down to the Sub-Sub Comparator. 

 It could not pass down the Master Vote bit that it inherited from the Master Comparator. 

You might need a Master Vote and Sub Vote bit in the Sub-Sub Comparator as shown below: 

 

Sub-Sub 
Comparator 
Bits 

Master 
Vote  

Sub 
Vote  

Steer Rx Dis Vote Fail 

 

 

 

 

To accomplish this, set up the following parameters: 

 Master Vote Bit Nudge = 6 

 Master Comparator Sub Devices: Sub Comparator & Sub-Sub Comparator 

(This passes the Master Vote bit directly down to both sub-levels) 

 Sub Comparator Vote Bit Nudge = 5 

 Sub Comparator Sub Device: Sub-Sub Comparator 

(This passes the Sub Vote bit down.) 

Since the Master Vote bit is nudged 6 bits, it will be nudged the same amount in each of its SubDevices.  

Thus, the bits for the Sub Comparator Display Table for this example should be set up as follows: 

Sub- 
Comparator 
Bits 

Master 
Vote  

Don't 
Care  

Steer Rx Dis Vote Fail 

 

 

 

 

When you fill out the States in this table, just make the Don't Care bit a "-" in all states. 

In this example, we were able to pass the Master Vote bit down two levels, but it was not passed through 

the Sub Comparator.  It was passed directly from the Master comparator to the Sub Comparator. 

"Native" bits from Sub-Sub Comparator CIB 
Inherited from Master 

Inherited from Sub Comparator 

"Native" bits from Sub-Sub Comparator CIB 
Inherited from Master 

Dummy bit because Master Vote Nudge = 6 
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Creating New Display Tables for Master and Sub Comparators 

This section shows how to add new display tables for Master or Sub Comparators.  It assumes that you 

are familiar with the Master and Sub device bit interaction as described in the previous section. 

Sub Comparator Display Table 

To add a tab for a new device to properly display the four Sub Comparators in our “Virtual Comparator” 

example system from Page 95,  

 Right-click on one of the existing tabs at the top of the Display Table window 

 Click on Append New Table.  The following window will be displayed.   

 

 

 Type in a new Tab Name such as “Sub Comparator ”.   

 Select the number of status Input Bits that this new device will possess.   

 

In addition to the 5 Input Bits of the predefined Comparator device, we will use an additional 

status bit to hold the Vote bit that will be inherited from the Master Comparator. So in this case, 

the number of Input Bits should be set to 6.   

 Click on OK to close this window.  A new blank display table will be entered with 6 bits. 

States Tab 

 Right-click anywhere on the States Table for this new “Sub Comparator” device, then click on 

Append to add lines for additional states.   

 Modify each state line in the States Table to satisfy the display requirements for this system’s 

“Virtual Comparator.  As shown in the following, a bright Green “Vote” will be displayed only 

when the Sub Comparator has voted (the Vote bit is set) and the Master Comparator has voted 

(the Master bit is set).   
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For our example of four Sub Comparators feeding into a Master Comparator, the States tab for a new 

“Sub Comparator” device may look like the following. 

 

Mouse Tab 

Next, the Mouse tab for this “Sub Comparator” display table should be modified to appear as follows. 

 

SubDevice Tab 

The Sub Comparator display table should have all bits set to "0" since we are not passing bits down from 

the Sub Comparator to a lower level device. 
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Master Comparator Display Table 

To add a tab for a new device to properly handle information from the Master Comparator in our 

example system, right-click on one of the existing tabs, then click on Append New Table.  The following 

window will be displayed.  Type in a new Tab Name,  such as “Master Comparator”.   

Then select the number of status Input Bits that this new device will possess.  This Master Comparator 

display table will have nearly the same function as the predefined “Comparator” Display Table, so in 

this case, the number of Input Bits should be set to 5.  Click on OK to close this window. 
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States Tab 

After the table is shown, we have to add the bit names as shown below.  Note that the bit order is not 

random; it must match the bits as they are received from the CIB modules. 

 

If the Master Comparators will never be displayed in an Equipment-Centric view, we could live with a 

minimalistic state table as shown above.  No additional lines would need to be added to define states,  

 

However, we've filled out the Master Comparator table as shown below so that a Master Comparator can 

be displayed in an equipment-centric view. 

 

 



MCNConfig Program:  Master-Sub Comparator Configuration 

 110 S2-61043-250 

Mouse Tab 

Next, the Mouse tab for this “Master Comparator” display table should be modified to appear as 

follows. 

 

 

SubDevice Tab 

Finally, the SubDevice tab for this “Master Comparator” display table must be altered to correctly pass 

its “Vote” bit to the Sub Comparator display table created earlier.  Since the “Vote” of the Master 

Comparator must be passed to properly display status of the “Virtual Comparator”, that bit should be 

masked by setting it to “1” as in the following window.  

Before the Master Comparator status information is sent to the Sub Comparator status information for 

proper display of a “Virtual Comparator”, this Master Comparator data is altered in two ways.   

 First, the data for any single status bit that is masked in the “SubDevice” tab will be promoted to 

the least significant (right-most) bit of the status word. 

 Second, the data in that least significant bit (Bit 0) will be “Nudged” a number of places to the 

left (specified in the “Nudge” column) so that it appears in the correct bit location for the Sub 

Comparator status. 
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For this example, the States tab for the “Sub Comparator” was modified earlier to specify that Bit 5 

will hold the “Vote” status from the Master Comparator.  So the bit must be “Nudged” from Bit 0 to Bit 

5.  Since the Bit is being nudged 5 places to the left, the “Nudge” parameter in the following display is 

set to 5. 
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MCNConfig Program:   
Master-Sub Comparator Configuration with Multi-
Dependency  

The features described in the previous “Master-Sub Comparator Configuration” section can be used in a 

more complex arrangement which adds “Multi-Dependency”.  Multi-Dependency can be defined as the 

ability of a Sub Comparator to inherit status bits from multiple Master Comparators.  This arrangement 

provides a level of redundancy and is depicted in the following diagram. 

 

 

With multiple masters as in this example, Sub Comparator status bits will be inherited from both Master 

Comparators.  The above diagram illustrates this for the first Sub Comparator with Master Vote A 

(MVA) and Master Vote B (MVB) vectors.  Likewise, the other Sub Comparators in this system will 

also inherit status bits from both Master Comparators. 

MVB 

MVA 
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Multidependency will let you display this system as two virtual comparators: 

 Virtual Comparator A using the Sub Comparators and Master A and 

 Virtual Comparator B using the Sub Comparators and Master B. 

The previous discussion under the section Multi-Bit Mask on page 104 will be used to build the Display 

Tables for this system.   

First we need to get the Vote bits from Master A and Master B passed down to the Sub Comparators. 

The diagram below shows that the Master Vote bit will be masked and passed to the SubDevice.  The 

Master A Vote will be nudged 5 bits, and the Master B Vote will be nudged 6 bits. 

 

  Master Comparator B 

Master B Bits   Steer Rx Dis Vote Fail 

Mask   0 0 0 1 0 

Masked      Vote  

Compressed & 
Shifted 

      Vote 

 

Master Comparator A 

      

Master A Bits   Steer Rx Dis Vote Fail 

Mask   0 0 0 1 0 

Masked      Vote  

Compressed & 
Shifted 

      Vote 

 

Sub Comparators 

       

Master A Nudged (5) 
Master B Nudged (6) 

Master B 
Vote 

Master A 
Vote 

     

Sub Comparator Bits Master B 
Vote 

(Inherited) 

Master A 
Vote 

(Inherited) 

Steer Rx Dis Vote Fail 

 

 

 

Inherited bits "Native" bits from Sub Comparator CIB 
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To accomplish the above, set up the following parameters: 

 Sub Comparator Display Table(s) with slots for Master Vote A & B 

 Master A Display Table with Vote Bit Nudge = 5 

 Master B Display Table with Vote Bit Nudge = 6 

 Master A Comparator Receiver slot Sub Devices: Sub Comparators  

 Master B Comparator Receiver slot Sub Devices: Sub Comparators 

Composite Sub Comparator Display Table 

A Composite Sub Comparator display table can be built as shown below: 

 

This can be used for somewhat of an equipment-centric view, but with added information about whether 

or not this sub comparator is also voted by the master comparator(s).  This display might be useful for a 

technician. 
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Multiple Views of the Virtual Comparators 

For a dispatcher, it is helpful to be able to display the example system as two virtual comparators: 

 Virtual Comparator A using the sub comparators and Master A and 

 Virtual Comparator B using the sub comparators and Master B. 

To do this, we need a Sub Comparator Display Table for both virtual comparators as shown below: 

For Virtual Comparator A: 

 

For this view, the dispatcher is interested only in what receiver is being used through the Master A 

comparator.  This Display table shows a "Vote" only when the Master A comparator has selected the sub 

comparator.  It ignores what the Master B comparator is doing. 

 

For Virtual Comparator B: 

 

For this view, the dispatcher is interested only in what receiver is being used through the Master B 

comparator.  This Display table shows a "Vote" only when the Master B comparator has selected the sub 

comparator.  It ignores what the Master A comparator is doing. 
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Master Comparators 

For the Master A Comparator, the SubDevices Tab of the Display Table should appear as in the 

following. 

 

And for the Master B Comparator, the SubDevices tab of the Display Table should appear as in the 

following. 
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Multiple Views:  Display Table Override 

So we may have a number of Display Tables set up to view a master or sub comparator, for example: 

 Equipment-Centric 

 Virtual Comparator 

 Enhanced Virtual Comparator 

 Composite Sub Comparator 

 Sub A 

 Sub B 

Looking at the Receiver window below, you'll see only one value for Display Table for each receiver.   

 

 

How do we use all these different Display Tables to take a different view of the comparators? 

The secret is to use the Display Table Override in the Display Windows.   

When a receiver is placed in a Display Window, you can use a special Display Table for that instance of 

the receiver by using the Display Table Override. 
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For example, if you want to display a system in two ways: 

 Virtual Comparator A (using Master A comparator) 

 Virtual Comparator B (using Master B comparator) 

You would set up a one tab for each Virtual Comparator as shown below: 

Virtual Comparator A 

                           

  Sub Comparator A Sub Comparator B Sub Comparator C Sub Comparator D-1 Sub Comparator D-2   

  Site 1   Site 9   Site 17 Rx Site 25   Site 33     

  Site 2 Rx Site 10   Site 18 Vote Site 26   Site 34     

  Site 3 Rx Site 11 Rx Site 19 Rx Site 27 Rx Site 35 Dis   

  Site 4 Rx Site 12   Site 20   Site 28 Rx Site 36     

  Site 5 Rx Site 13   Site 21 Rx Site 29   Site 37     

  Site 6 Rx Site 14 Rx Site 22   Site 30   Site 38     

  Site 7   Site 15 Rx Site 23 Rx Site 31   Site 39     

  Site 8 Dis Site 16   Site 24   Site 32   Site 40     

                        

       
 
 

    

Virtual Comparator B 

    

                        

  Sub Comparator A Sub Comparator B Sub Comparator C Sub Comparator D-1 Sub Comparator D-2   

  Site 1   Site 9   Site 17 Rx Site 25   Site 33     

  Site 2 Rx Site 10   Site 18 Rx Site 26   Site 34     

  Site 3 Rx Site 11 Rx Site 19 Rx Site 27 Rx  Site 35 Dis   

  Site 4 Vote  Site 12   Site 20   Site 28 Rx Site 36     

  Site 5 Rx Site 13   Site 21 Rx Site 29   Site 37     

  Site 6 Rx Site 14 Rx  Site 22   Site 30   Site 38     

  Site 7   Site 15 Rx Site 23 Rx Site 31   Site 39     

  Site 8 Dis Site 16   Site 24   Site 32   Site 40     

                        

            

 

The Display Windows are similar, with the following differences: 

 Master Comparator A is voting Sub Comparator C and using Rx 18. 

 Master Comparator B is voting Sub Comparator A and using Rx 4. 

If the Dispatcher had the A-B switch in position "A", he would hear audio from Rx 18.  If he had it in the 

"B" position, he would be hearing Rx 4. 
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To build this display we us the Display Table Override feature.  For each receiver in a Display Window 

that will use a different Display Table than chosen in the Receivers Window, right-click its cell in the 

Display Window as shown below.  

 

 

  

 

Then click the Override Display Table menu item to display the following window. 

 

Choose Sub A, and then click OK.  The Display Window will indicate receivers with Display Table 

Overrides with a Reddish background as shown below.  The cells for other receivers using their default 

Display Table will have a green background. 

 

Repeat this procedure for each receiver that should have an override for the default Display Table.   

The Display Table for all receivers of a comparator can be overridden.  And taking it a step further, the 

Display Table for all receivers in a Display Window can be overridden.  To make Display Table 

Overrides to many receivers at once, perform the following steps: 

 Select all receivers that you wish to override with a type of Display Table. 

 Right-click the selection, then click the Override Display Table menu item to display the 

Override Display Table window. 

 Select the proper Display Table from the list, then click OK. 

Right–click to choose Override Display Table 
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If all receivers in the above Display Window were selected to be overridden with Sub A Display Table, 

the Display Window would appear as follows. 

 

 

Likewise, for Comparator B, the result would look like: 

 

 

Note that in this system, the default Display table for these sub comparators was "Subcomparator".  We 

would probably use the default for an equipment-centric view.  For this dispatcher display, however, 

both views use Display Table Overrides. 

 

NNoottee::    DDeeffaauulltt  DDiissppllaayy  TTaabblleess  

TThhee  MMCCNNRRCCDD  pprrooggrraamm  ppaasssseess  bbiittss  ddoowwnnssttrreeaamm  ffrroomm  aa  MMaasstteerr  ddeevviiccee  ttoo  ssuubb  ddeevviicceess  uussiinngg  tthhee  DDiissppllaayy  

ttaabbllee  tthhaatt  iiss  iinn  tthhee  RReecceeiivveerr  wwiinnddooww..    YYoouu  mmuusstt  uussee  tthhee  pprrooppeerr  DDiissppllaayy  TTaabbllee  ((tthhee  oonnee  wwiitthh  tthhee  SSuubb  

DDeevviiccee  BBiitt  MMaasskk  &&  NNuuddggee))  aass  tthhee  ddeeffaauulltt  DDiissppllaayy  TTaabbllee  iinn  tthhee  RReecceeiivveerr  wwiinnddooww
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Mcn Standard Program 

This is the software run on the Mcn Standard PC.  It has a local display that displays the status of the 

devices on the MCN system (Comparators, I/O points, alarms, etc.).  It allows the operator to control 

receivers (with Force-Vote and Disable functions) and other I/O devices (relays, etc.) from the Mcn 

Standard PC.  

 

The Mcn Standard program does not support any remote Clients. 

 

Warning:  Do not run the DOS version of MCNRCD and the Mcn Standard program at the 
same time on the same Network Interface! 

This will cause sluggish operation.  You may notice modules going off-line, responding very slowly, or 

even not responding at all to mouse presses. 

 

First Time Setup 
The Mcn Standard program needs to set up a number of parameters before it can function.  When you 

run the software for the first time, it will ask you to enter some values. 

 

 

Selecting an Ethernet NIC to talk to the HIB-IP units  
Next, the program needs to know which Ethernet NIC card will be used to talk to the HIB-IP units.  The 

IP Settings window appears and asks you to select an IP address (associated with a NIC card in your PC) 

that you will use to talk to the HIB-IP units. 

 

 
 

Select an IP address and NIC card using the drop-down list.  There will be an entry for each combination 

of IP addresses and NIC cards in your PC.  Typically you will have only one NIC card, so you will 

probably have only one entry. 

 

The program will ask for this information even if you don't have any HIB-IP units in your system.  

Humor the program and select an IP address and NIC card anyway. 
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Windows UAC Permission 

The Mcn Standard application needs to permission to make changes.  If you have the UAC enabled, you 

will need to give the Mcn Standard program access.   

 

Select the Yes option. 

Screen Elements 

 

 

Controlling the Mcn Standard Window 

You can control the Mcn Standard window as follows: 

 Move the window by grabbing its title bar and dragging it. 

 Re-size the window by grabbing an edge or corner and dragging it. 

 Minimize /Restore, Maximize and Close the window using the standard Windows buttons on the 

top right corner of each window. 

Menu 

Title Bar 

Min / Max / 
Close 

Buttons 

Status 
Line 
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Display Element Properties  

More information can be obtained about each specific receiver by performing a shift and left click over 

the particular screen element and bringing up the Display Element Window.  

 

 

  

Display Label Properties  
More information can be obtained about each Label, by performing a shift and left click over the 

particular screen Label and bringing up the Display Label Properties Window.  
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Menus 

This program has many standard menu functions that are used in other Windows programs.  For 

example, menus can be selected with the mouse or by hitting the ALT key & the underlined letter on the 

menu. Note that a menu’s appearance may change, and various menu options may be disabled, 

depending on the current state of the system. 

File Menu 

 
 

Open Opens a Display Window created in the MCNConfig 

program. 

Recent Files Allows you to quickly open a recently used Display 

Window. 

Exit Exits the program. 

Options Menu 

 
 

Logging & Sound Alerts can be sent to the PC screen, printer, file, or email 

recipients. Alert sounds can also be enabled. 

Email Setup Email parameters must be entered before email alerts can 

be generated. See Alarm Display – Log Tab / Alarms Tab  

If a Receiver or I/O point is configured for Alarm operation, it will be displayed on the Alarms tab of the 

System Event window when it goes into an Alarm state.   

 



MCN Standard Program 

 125 S2-61043-250 

 
 

This tab shows all alarms which are: 

 Active and/or 

 Unacknowledged. 

The state shown will be the state at the latest time the alarm became active.  It does not necessarily show 

the current status. 

 

If an alarm state has a sound configured for it, that sound will be played when a point goes into the alarm 

state.  For multiple alarms, the alarm sound will not be repeated unless 2 seconds has elapsed since the 

previous alarm. 

 

Alarms must be acknowledged.  They can be acknowledged with either: 

 The Ack All button or 

 The Ack drop-down field in the individual alarm line. 

 

Alarms will be removed from the window when: 

 The alarm is acknowledged and  

 The state returns to normal 

 

If there is a nuisance alarm, it can be placed on Ignore status with the Ignore field. 

 

Receivers and I/O points can be configured for Alarm operation by selecting an appropriate Display 

Table.  Alarm activity can also be enabled on an existing Display Table.  See the Alarms and Display 

Tables section starting on page 66 for instructions on how to enable alarms and sounds in the Display 

Tables. 

Email Setup on page 127 for other requirements for email alerts. 

Printer Setup Printer parameters must be entered before alerts are sent to 

a printer. 

Font Used to change the Font type or size for the display grid. 

IP Settings Lets you select the appropriate IP address to communicate 

with a HIB-IP unit (if you are using a HIB-IP for your 

Network Interface). 
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Enabling & Disabling Logging 

Alerts generated by the Mcn Standard program can be sent to the PC screen, printer, file, or via email to 

selected recipients. Alert sounds can also be enabled. 

The following window will be displayed when Logging is selected from the Options Menu. 

 

 

 

 

   

Select the types of logging required, then click the OK button. 

 

If logging to File is enabled, the file is named MCNRCD.log and is located in the Mcn Standard system 

directory. This is normally at: 

C:\ProgramData\CTI Products Inc\McnRcd  

If logging to Screen is selected, then logs are displayed for each detected system event appropriately 

configured in the display Table of the system configuration. 

Sounds will only accompany alarm events, if configured in the Display Table of the system file. 

 

NOTE: Unnamed receivers and I/O points are considered unused by the program so that all transitions 

are ignored and will not generate alarms or logs.    

System Events Window 

The history of Logs and Alarm Statuses are available under the System Events Window. The appropriate 

selections must first be configured in the States Tab of the Display Table with Mcnconfig. Then, if the 

logging to screen is enabled this window will automatically pop up and update for each valid Log and/or 

Alarm event. 

When Screen Logging is enabled, status changes will be listed on the screen as shown below. 

 

 Hitting the OK button will close the window but keep the log entries. 

 Hitting Clear will delete the log entries. 

 

You can view the Log & Alarm window later by selecting View / Log Window from the menu. 
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Alarm Display – Log Tab / Alarms Tab  
If a Receiver or I/O point is configured for Alarm operation, it will be displayed on the Alarms tab of the 

System Event window when it goes into an Alarm state.   

 

 
 

This tab shows all alarms which are: 

 Active and/or 

 Unacknowledged. 

The state shown will be the state at the latest time the alarm became active.  It does not necessarily show 

the current status. 

 

If an alarm state has a sound configured for it, that sound will be played when a point goes into the alarm 

state.  For multiple alarms, the alarm sound will not be repeated unless 2 seconds has elapsed since the 

previous alarm. 

 

Alarms must be acknowledged.  They can be acknowledged with either: 

 The Ack All button or 

 The Ack drop-down field in the individual alarm line. 

 

Alarms will be removed from the window when: 

 The alarm is acknowledged and  

 The state returns to normal 

 

If there is a nuisance alarm, it can be placed on Ignore status with the Ignore field. 

 

Receivers and I/O points can be configured for Alarm operation by selecting an appropriate Display 

Table.  Alarm activity can also be enabled on an existing Display Table.  See the Alarms and Display 

Tables section starting on page 66 for instructions on how to enable alarms and sounds in the Display 

Tables. 

Email Setup 

For Email logging to occur, the following setup requirements must be met: 

1. In the MCNConfig program, email groups and recipients must be specified in the "Email 
Groups Resource Window" on Page 60 for more information. 
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2. In the MCNConfig program, the "Email Group" must be specified for each Channel in the 

"Channels Resource Window" on Page 58 for more information. 

3. In the MCNConfig program, the "Email" log flag must be set to "Y" in the Display Table 

States tab for those statuses you wish to be sent to the email.  See page 68 for more 

information. 

4. Enable Email alerts in the "Logging & Sound" window. To navigate to this window, select 

"Logging & Sound" from the Options Menu. See page 126 for more information. 

5. Email parameters must be provided in the following window. To display this window, choose 

“Email Setup” from the Options Menu.   

  
 

Parameters in the above window should be obtained from the email administrator at your 

facility. 

Server IP address or name of the email server at this facility. This can be either 

numeric address (such as 10.0.0.41) or a name that points to the email 

server through a Domain Name Server (DNS), as shown above. 

Port Email server port for accepting incoming mail messages, referred to as 

the “Listen Port” 

Name A valid email address that the above server services. MCN email alerts 

will be “From” this email address. The domain name (the portion of an 

email address after the "@" symbol) should not be included in this field. 

Password A valid password for the email address used in the “Name” field above. 

Email Setup Verification 

A “Test” button is provided in the “Email Setup” window to verify if all email parameters are set 

correctly. Click on this Test button to display the “Email Test” window shown below: 

 

To send a test email, select an Email Group from the drop-down list, then click Send.  If successful, the 

following “Test Passed” window will be displayed. 

 

NNOOTTEE::  TThhee  MMCCNN  EEmmaaiill  SSeettuupp  wwiillll  

oonnllyy  ssuuppppoorrtt  MMaaiill  SSeerrvveerrss  rruunnnniinngg  

LLeeggaaccyy  vveerrssiioonnss  ooff  tthhee  PPOOPP  oorr  IIMMAAPP  

sseeccuurriittyy  pprroottooccoollss..  
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Another way to verify that the Mcn Standard program has successfully logged into the email server in 

the window above (and an email has been submitted for transmission), is to notice the Status Bar at the 

bottom of the Mcn Standard display window.  If successful, the "Email Sent" status message will be 

displayed as shown below. 

 

 

This email message will be delayed until the "Holdoff Time" specified in the "Email Group" properties 

window has expired. Navigate to this parameter in the MCNConfig program by right-clicking on a tab of 

the "Email Groups" Resource Window, then select Email Group Properties.  See Email Hold off 

Time on page 60 for more information. This message will be visible for approximately 15 seconds. 
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If the Mcn Standard program was unsuccessful at logging into the email server, an error 

indication will be logged to screen as shown below. Screen logging does not have to be enabled 

for this type of screen log to occur. 

  

Printer Setup 

For alerts to be printed, printer parameters must be provided in the following screen. To display this 

window, choose “Printer Setup” from the Options Menu. 

 

Parameters in the above window can be obtained from the specific printer documentation. 

 Printer Initialization String This Escape character sequence is sent to the printer at the 

start of a new print job. In the example above, ^O instructs 

the printer to print without using a bottom margin, since 

continuous paper will be used.  ^M selects 10.5 points for 

the font height and 12 characters per inch horizontally. And 

^J specifies the line feed distance. 

 End of Line This Escape character sequence is sent to the printer after 

each line of print. Normally, this should consist of escape 

characters for “line feed” and “carriage return”. 

 Lines per Page Enter the number of lines to be printed on each page. 

 Form Feed/Page Eject This Escape character sequence is sent to the printer after 

the number specified in “Lines per Page” above have been 

printed on a page. 

 Printer Name A drop-down list is provided to select from the installed 

printers on this PC. 
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Font 

The Font Selection window is used 

to select a font and a font size for 

the Receivers and Function Blocks 

in the Display Window.  

 

The row sizes will automatically 

stretch or shrink in response to font 

size changes.  You may have to 

manually change the column widths 

after you make a change. 

 

 

 

 

 

IP Settings 

The window below is used to select the appropriate IP addresses on your PC to use in communicating 

with the HIB-IP unit(s) (if used) and the Client PCs. 
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View Menu 

 

Toolbar When checked, enables the Toolbar. 

Status Bar When checked, enables the Status Bar (at the bottom of the 

Mcn Standard display window). 

Top Most Window When checked, ensures that the Mcn Standard display 

window is always the Top Most Window. 

NI Status Opens the Network Interface Status window to display the 

status of all Network Interfaces in use by the Mcn Standard. 

Layout Mode When checked, allows column widths to be adjusted, 

“Layout Mode” will be indicated in the Status Bar (at the 

bottom of the Mcn Standard display window). 

Save Layout Use this command to save column width changes 

performed when in Layout Mode. 

 

The following figure shows the Toolbar and Status Bar enabled. 

  
 

  

Toolbar 
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NI Status Window 

The NI Status Window shows the status of the Network Interfaces associated with this system. 

The Standard software supports only a single Network Interface.   

 

Network Interface Properties Display 

For additional information on the Network Interface, right-click on the selected Network Interface and 

select the Properties menu item. 

 

The Properties will vary, depending on what type of Network Interface is in use.   

 

 PCLTA Properties HIB-IP Properties 
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Additional HIB-IP Diagnostic Functions 

When you Right-Click on a HIB-IP Network Interface, you have two additional diagnostic options:  

Wink and CSVC.  

 

Wink This will blink the "Wink" LED on the front of the HIB-IP unit. 

This can be helpful to identify problems with a HIB-IP unit. 

CSVC This is the equivalent of pressing the CSVC button on the front of the HIB-IP unit.   

In special instances a CTI engineer may instruct you to click on the CSVC function. 

 

Layout Mode 

The following figure shows the Mcn Standard Display Window in Layout Mode. 
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Help Menu  

   
 

 Operating System Info 
 The operating system info will display relevant details about the OS on which the MCN 

Program is installed.   

  

 

 

 About McnRcd… 

 The about McnRcd, will display relevant details about the currently installed McnRcd Program 

and its Licensing. 
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File Menu 
The File menu  has the following menu items: 

 Open Allows you to select a new screen 

 Exit Allows you to exit the program 

 

 

Open 

The Open window may show a list of screens if available which can be loaded by the Mcn Standard 

program. 

 

 Select the appropriate screen from the list presented and hit OK. 

 The new screen will appear: 
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Options Menu 
The Options menu has the following menu items: 

 Font Allows you to adjust the font type and size for this screen. 

 IP Settings Allows you to change the IP settings (as described earlier) 

 

 

Font Window 

The Font Selection window is used to select a font and a font size for the Receivers and Function Blocks 

in the Display Window.  

 

 
 

The row sizes will automatically stretch or shrink in response to font size changes.  You may have to 

manually change the column widths after you make a change.  See page 139 for directions for setting 

column widths. 
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IP Settings 

This IP Configurations window is the same window that appears when the MCN Client program is run 

for the first time. 

 

If you change any of the settings, they will not take effect until you re-start the MCN Client program. 

 

If you click the “Now” button the program will automatically end, however it will manually need to be 

restarted.   
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View Menu 
The View menu is similar on all MCN versions. 

 

 
 

Toolbar Turns the Toolbars on or off. 

Status Bar Turns the Status Bar (at the bottom of the screen) on or off. 

Top Most Window Allows MCN Client window to stay on the top of other 

programs that are running. 

Layout Mode This allows you to edit the column widths.    

Save Layout Saves the column widths and Display Window position.   

Layout Mode 
When this is on, you can drag the vertical column bars.  The unused cells turn gray to indicate you are in 

Layout mode.   

 

All the Receiver columns have the same size and all the Status columns have the same size.   

 

 
 

When in Layout Mode, the program will not send mouse clicks to the Mcn Standard. 

Turn off Layout Mode to enable normal program operation. 

In Layout Mode 

Click & Drag Column Separator lines 

to change column widths. 

Layout Mode Indicators: 

 

Gray Cells 

  and 

Layout Mode status 
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Appendix:  Running LonScript Under Debug  

LonScript: 
This is an Engineered System Custom Configuration 
Programming feature, which can be used to program the 
Routers and EXB modules with special custom address 
forwarding tables.  
 

ROUTER and EXB module scripts will typically only be used during initial system installation, system 

expansions, and/or  spare replacements.  During initial system installation the scripts could be used to 

verify that the ROUTER configurations match the units contained in that ROUTER network.   

 

Warning: Any of the operations mentioned or described, may only be performed under  

  the direction of CTI Products.   

  

Purpose of Custom Configuration 
A Custom configuration that is specific for each system can be programmed in to the Routers of EXB 

modules as required to segment traffic flow, so as to pass only the required traffic and not overload the 

lower speed channels in the system.  For instance, routers may be programmed to pass traffic from CIBs 

on the 78K side to the 1.25M side, but to block CIB traffic from the 1.25M side to the 78K side.  

 

Enabling LonScript 
The Lonscript feature is available and accessible from within all MCNRCD program versions except for 

McnServer 8000.  The feature is enabled through the software by adding ‘ / debug’ to the Desktop 

Shortcut path that runs the application e.g. “C:\Program Files (x86)\CTI Products Inc\McnRcd  

Standard\McnRcd Standard.exe” /debug. 

 

 A Special Custom Script file is required. If the system has been qualified for custom configuration 

A CTI Products Disk will be included with your order. Please contact CTI Products if the disk is missing 

as this is the only way to acquire the appropriate files. 

 

Note: Misuse of this feature could permanently disable your hardware. Always contact CTI Products for  

assistance. 
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Appendix:  Fixing a Botched PCLTA Installation 

The PCLTA drivers must be loaded prior to installing the PCLTA card.  If the PCLTA card was installed 

first, and an attempt was made by the Windows operating system to load the drivers, follow these steps 

to re-install the drivers correctly: 

Navigate to the Control Panel from the Start Menu,  then click the “Device Manager” icon from the 

window as shown below.  (If the icons are not visible, change the Control Panel to “View by: Large 

Icons”.) 

 

In the “Device Manager” window Check the hardware list under Network adapters.  If the driver for 

PCLTA network interface is not installed correctly, “Other Devices” will be listed (instead of 

“LonWorks Network Interface”).  Expand the “Other Devices” icon so that “Network Controller” is 

listed as shown below. 

 

Select “Network Controller” with an “ ” through its icon, then from the Action Menu, select 

“Disable”.  Follow any additional prompts, and restart the PC. 

The PCLTA driver can now be reinstalled from the distribution CD (S2-61502). 



 

142 

S2-61043-250 

 

Appendix:  Error Logging Definitions 

Logging is a feature of the MCN and the RCD Programs to assist with System Hardware Status, Trouble 

shooting and Diagnostics. The messages to be logged are formatted for general text output. The 

formatting of messages to be logged to the screen, printer, file, or email is defined a file 

C:\Users\UserName\MyDocuments\MCNRCD\MCNRCD.Log   (Where UserName is the Windows 

User name under which you were logged on when the program was last running and logging.).  This file 

is automatically created from the MCNConfig program when a new system is defined, and updated when 

a system is edited.  If the format of resulting error logs is not suitable, a text editor can be used to edit the 

C:\Users\UserName\MyDocuments\MCNRCD\MCNRCD.Log file to produce a customized format. 

Logging to a File 

The typical logging definitions for a file are shown in the example below. 

 

Logging to Email 

The application is capable of send the same logged data via Email. However only SMTP 

is supported. 
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Logging to a Printer 

The typical logging definitions for printing are shown in the example below. 

 

Logging to the PC Screen 

The typical logging definitions for screen are shown in the example below. 
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Error Logging Definition File Parameters 
Email Subject Line The text between quotes on this line will appear in the 

subject line of email alerts. 

Email Recipients Information in this section includes the “Email Groups” 

specified in the MCNConfig program and should not be 

edited. 

Log File Name The text between quotes is the file name that logs will be 

saved to. 

Printer Device Name The text between quotes is the default printer device name 

“device”.  This should not be edited 

Log Window Title The text between quotes on this line will appear in the title 

block of the displayed log window. 

Header Text (column titles) The text between quotes on this line will be the first line in 

the body of the email, file, printout, or screen. 

Fields to Log For each field to be logged, the following four parameters 

must be specified: 

 Column for start of field 

 Field Name, or text enclosed in quotes (see Field Name 

table below) 

 Beginning character position to be printed for field 

 Ending character position to be printed for field 

 Field names are defined below. 

Field Name Description 

Date Date of state change. Format is mm-dd-yyyy 

Time Time of state change. Format is hh:mm:ss 

Oldstate State of signal prior to change 

Newstate Current state of signal 

Gmr Group, Module, Receiver address of signal. Format 

is gg:m:rr 

Channel Channel name 

Rxname Receiver name 

Desc Description of Receiver name 

“text” Text between quotes will be logged as written 
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Glossary 

 

1250 1.25mbps high speed backbone Network Rate 

78K 78kbps standard network rate for CIB, HIB, AIB, IIB, and IOB modules. 

AIB ASTRO-TAC™ Comparator Interface Module connects a Motorola ASTRO-

TAC™ comparator to the MCN Network.  It extends the comparator lights and 

switches over the network to a remote display position (either a PC or console 

display). 

CIB Comparator Interface Module connects a voting system comparator to the MCN 

Network.  It extends the comparator lights and switches over the network to a 

remote display position (either a PC or console display). 

CTI Shorthand for our full company name, "CTI Products, Inc." 

The initials "CTI" come from our parent company -  

 Combined Technologies, Inc. 

"CTI" is used in some circles -- but not in this manual-- to mean  

"Computer Telephony Integration"; but we, were using this acronym first! 

EXB System Extender Module is used in pairs to connect two MCN networks together or 

the extend the length of an MCN network beyond 4000 feet.  Allows control and 

monitoring of multiple remote comparators from a central site. 

Group Equivalent to the Subnet portion of the network address, less one.  Valid values are 

from 00 to FE (hexadecimal). 

HIB-232 This Host Computer Interface Module connects a PC to the MCN Network over an  

RS-232 connection.  It can be local to the PC or connected through  leased-line 

modems or an equivalent full-time RS-232 channel. 

HIB-IP This Host Computer Interface Module connects a PC to the MCN Network over an 

IP network.   

IIB Input/Output Interface Module connects a parallel operator display device (such as a 

console) to the MCN Network.  Can be used with AIB ASTRO-TAC™ Comparator 

Interface Modules to provide voting status indications (Vote, Receive, Disable, and 

Fail) to a console.  Also can be used with CIB Comparator Interface Modules to 

extend the comparator display and control for other comparators over a long 

distance. 

IOB Input/Output Control Module connects I/O devices such as relays to the MCN 

Network.  Used with a HIB to create an I/O control system. 

IP Internet Protocol 

IP Address Any node connected to an IP (Internet Protocol) network must be identified with a 

unique 32-bit address.  These 32-bit addresses are commonly written in dotted 

decimal notation as four decimal numbers (referred to as octets because each 

decimal number represents 8 bits) separated by decimal points.  Each octet can be a 

number from 1 to 255. For example, 131.9.1.2 is a valid IP address.   

IP Subnet A portion of an IP network that encompasses a specific range of IP addresses (ex: 

from 10.1.1.0 to 10.1.1.255).  All IP devices on the same subnet talk to each other 

directly (or through hubs or switches).  They do not need a router between them.  

(See also Subnet Mask.) 

MCN Monitoring and Control Network 
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Module Equivalent to the Node portion of the network address, less one. Valid values are 

from 00 to 7E (hexadecimal) for MCN modules. 

NIC Network Interface Card – Interface card between the PC and the Ethernet network. 

PBX Private Branch Exchange (In-house telephone system switch) 

PCLTA Internal MCN Network Interface for PC 

Port (IP) A number indicating a logical connection within an IP device.  Ports allow multiple 

types of messages (email, HTTP, FTP, etc.) to be sent to the same IP address.  The 

IP device decides what to do with each message depending on which port it is 

addressed to. 

PSTN Public Switched Telephone Network (Dial-Up phone system) 

RCD Remote Comparator Display  

Subnet Mask The bits that define the Subnet range.   A portion of the IP Address Bits (normally 

the upper bits) are used to define the subnet range.  The subnet mask identifies the 

“NetID” and “HostID” portions of the IP address in a bitwise fashion.  The mask is 

constructed by placing a “1” in any bit that is part of a subnet (NetID) address.  So 

subnet mask bits that are SET define the NetID, and CLEARED subnet mask bits 

define the HostID. 

 

A subnet mask of 255.255.255.0 defines the NetID as the first three octets, and the 

HostID as the last octet.  For example, for the address 192.47.73.111 and the subnet 

mask of 255.255.255.0, the subnet can be identified as 192.47.73.0.  
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